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OCEAN CONVEYOR BELT

Grade Level: Lessons 1 and 2 are appropriate for students in grades 8—-12. Lessons 3 and 4 are suitable for students in
grades 10-12.

Standards: This kit is aligned with state science and math content standards for Hawai‘i, California and Oregon, as well
as national Ocean Literacy Principles.

Overview: Collecting and analyzing oceanographic data help students appreciate the relevance of marine science to
their own lives and to understand the value of technology in science. This four-lesson kit introduces students to some
fundamental concepts in oceanography including ocean circulation, nutrient cycling, and variations in the chemical,
biological, and physical properties of seawater through hands-on and computer-based experiments. Each lesson is
designed to be completed in about 70 minutes, but the activities are discrete and can be rearranged to fit various
curricular objectives and time constraints. Pre- and post- surveys are included to assess student learning.

Lesson 1: Water Stratification (hands-on experiment)

At the beginning of the unit, students work in small groups as they experiment with and measure different water
properties. Students collect and graph data to understand how and why water masses become stratified. The lesson
ends with a narrated PowerPoint presentation to review concepts of density and ocean structure.

Lesson 2: Deep Ocean Circulation (paper model and worksheet)

A narrated PowerPoint presentation helps students apply what they learned during their Lesson 1 experiments to the
density-driven circulation of the entire ocean. Students make a Mobius strip model of thermohaline circulation and fill
out a map and worksheet to reinforce their knowledge.

Lesson 3: Using Data to Explore Ocean Processes (Internet-based lesson)

A narrated PowerPoint presentation introduces students to long-term oceanographic studies (“time-series”) and
discusses how physical, chemical, and biological variables change with depth and time. Students then work at
computers in small groups and use the Internet to access a 20-year oceanographic data set. Using the worksheet
provided, students graph and interpret seasonal shifts in temperature, phytoplankton, and nutrient abundances.

Lesson 4: Nutrients and Ocean Circulation (Excel-based lesson)

This culminating lesson integrates and tests every principle that the students have learned in the unit about ocean
circulation, biogeochemistry, and visualizing and interpreting data. After viewing a brief PowerPoint presentation,
students use online databases of oceanographic time-series data in the Atlantic and Pacific Oceans to graph, analyze,
and interpret data about nutrient concentrations in different parts of the world. An optional extension activity
enables students to extract the data directly from the online databases.

Suggestions for Curriculum Placement: This science kit can be successfully integrated into earth science, biology,
environmental science, marine science, physical science, chemistry, physics, or math curricula. These lessons provide
students with multiple opportunities to generate hypotheses, collect data through hands-on experimentation, employ
a variety of technologies, utilize existing oceanographic data sets, and analyze results. Students learn how regional
data collection can be applied to better understand global processes such as climate regulation, ocean circulation, and
biogeochemical cycling.

©Center for Microbial Oceanography: Research and Education (C-MORE). Materials may be duplicated and
distributed for educational, non-commercial purposes only.



(Paper materials contained in binder are shown in BOLD CAPS)

Front Binder Materials
1. CD with narrated PowerPoint presentations (also contains electronic versions of binder materials)
2. C-MORE Key Concepts in Microbial Oceanography brochure
3. C-MORE Microbial Oceanography: Resources For Teachers brochure
4. TEACHER SUPPLEMENTAL INFORMATION

Lesson 1: Water Stratification
Materials are provided for students to work in 7 groups. We recommend 4-5 students per group.

20.
21.
22.

23.
24.
25.
26.

TEACHER GUIDE - Lesson 1: Water Stratification

OCEAN CONVEYOR BELT SURVEY - Lessons 1 and 2

TEACHER ANSWER KEY to OCEAN CONVEYOR BELT SURVEY - Lessons 1 and 2

MATERIALS PHOTO GUIDE - Lesson 1: Water Stratification (Teacher Supplies)

MATERIALS PHOTO GUIDE - Lesson 1: Water Stratification (Water Containers and Student Supplies)

. HOT WATER DISPENSER GUIDE - Lesson 1: Water Stratification

. SALINITY METER GUIDE - Lesson 1: Water Stratification

. SALINITY APPROXIMATION TABLE — Lesson 1: Water Stratification

. Color-coded GROUP EXPERIMENT cards (8)

. STUDENT WORKSHEET - Lesson 1: Water Stratification

. TEACHER ANSWER KEY to STUDENT WORKSHEET — Lesson 1: Water Stratification
. POWERPOINT SCRIPT - Lesson 1: Water Stratification

. Large plastic tanks with bottom and one side painted white (3)

. Clip-on labels for tanks during group experiments (2)

. One large plastic re-sealable bag containing:

0 Wooden blocks (3)
1500 ml Measuring Bottle (1)
1000 ml Demonstration Water bottle (1)
250 ml beakers (4)
100 ml beakers (2)
Probe Rinse Water beaker (1)
Measuring spoon sets (% tsp, % tsp, 1 tsp) (2)
Plastic spoons (2)
Small salt container (1)

0 4 colors of food dye: Red, Yellow, Green, and Blue (2 each)
Oakton SALT 6 hand-held salinity meter (1)
Small plastic tanks (7)
Small plastic re-sealable bags (7), each containing:
Wooden block (1)
100 ml beaker (1)
Measuring spoon set (% tsp, % tsp, 1 tsp) (1)
Plastic spoon (1)
Small container filled with ~ % cup of salt (1)
2 colors of food dye: Red and Blue (1 each)
Hot water dispenser with power cord
Red cooler
Collapsible water carrier
Extra salt for refilling small containers
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Lesson 2: Deep Ocean Circulation
Materials are provided for students to work in 7 groups of 4 students per group.
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TEACHER GUIDE - Lesson 2: Deep Ocean Circulation

POWERPOINT SCRIPT — Lesson 2: Deep Ocean Circulation

STUDENT WORKSHEET - Lesson 2: Mapping Deep Ocean Circulation

MOBIUS STRIP (Part A) — Lesson 2: Mapping Deep Ocean Circulation

MOBIUS STRIP (Part B) — Lesson 2: Mapping Deep Ocean Circulation

BLANK WORLD MAP

TEACHER ANSWER KEY to STUDENT WORKSHEET - Lesson 2: Mapping Deep Ocean Circulation
TEACHER ANSWER SHEET — Deep Ocean Circulation Map

NATIONAL GEOGRAPHIC NEWS article

STUDENT WORKSHEET - Lesson 2: Ocean Circulation Article

TEACHER ANSWER KEY to STUDENT WORKSHEET - Lesson 2: Ocean Circulation Article
Laminated Mobius strip teacher answer key

Colored pencils (14 each of red, blue, and purple)

Scissors (7)

Transparencies of Surface Ocean Currents (7)

Lesson 3: Using Data to Explore Ocean Processes

42.
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TEACHER GUIDE - Lesson 3: Using Data to Explore Ocean Processes

POWERPOINT SCRIPT — Lesson 3: Using Data to Explore Ocean Processes

STUDENT WORKSHEET — POWERPOINT - Lesson 3: Using Data to Explore Ocean Processes

TEACHER ANSWER KEY to STUDENT WORKSHEET — POWERPOINT — Lesson 3: Using Data to Explore Ocean
Processes

STUDENT WORKSHEET — HOT-DOGS - Lesson 3: Using Data to Explore Ocean Processes

TEACHER ANSWER KEY to STUDENT WORKSHEET — HOT-DOGS - Lesson 3: Using Data to Explore Ocean
Processes

Lesson 4: Nutrients and Ocean Circulation
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TEACHER GUIDE - Lesson 4: Nutrients and Ocean Circulation

OCEAN CONVEYOR BELT SURVEY - Lesson 4

TEACHER ANSWER KEY to OCEAN CONVEYOR BELT SURVEY - Lesson 4

POWERPOINT SCRIPT — Lesson 4: Nutrients and Ocean Circulation

STUDENT WORKSHEET — Lesson 4: Nutrients and Ocean Circulation (Excel 2003)

STUDENT WORKSHEET — Lesson 4: Nutrients and Ocean Circulation (Excel 2007)

TEACHER ANSWER KEY to STUDENT WORKSHEET - Lesson 4: Nutrients and Ocean Circulation
STUDENT INSTRUCTIONS - Lesson 4 Extension: Data Extraction (Excel 2003)

STUDENT INSTRUCTIONS - Lesson 4 Extension: Data Extraction (Excel 2007)

GLOSSARY

TEACHER EVALUATION

SUPPLY CHECKLIST

Manuals for Hot Water Dispenser and Salinity Meter
Speakers

Water

Ice

Paper towels

Transparent tape

Projector

Computer with PowerPoint software and CD drive



68. Student computers with MS Office Excel (required for Lesson 4) and high-speed Internet access (required for
Lesson 3 and 4)

State Standards for Hawai‘i, California and Oregon. The following science and math standards and benchmarks can
be addressed through this C-MORE science kit:

Hawai‘i Content & Performance Standards (HCPS 111):
Science Standard 1: The Scientific Process: Discover, invent, and investigate using the skills necessary to engage in the
scientific process.

Grade 8 Benchmarks for Science:
SC.8.1.1 Determine the link(s) between evidence and the conclusion(s) of an investigation.
SC.8.1.2 Communicate the significant components of the experimental design and results of a scientific investigation.

Grades 9—12 Benchmarks for Physical Science, Biological Science, Earth and Space Science, Environmental Science,
Marine Science, Chemistry, Physics, and Plants and Animals in Hawai'i:

SC.PS/BS/ES/ENV/MS/CH/PH/PAH.1.1 Describe how a testable hypothesis may need to be revised to guide a scientific
investigation.

SC.PS/BS/ES/ENV/MS/CH/PH/PAH.1.2 Design and safely implement an experiment, including the appropriate use of
tools and techniques to organize, analyze, and validate data.

SC.PS/BS/ES/ENV/MS/CH/PH/PAH.1.3 Defend and support conclusions, explanations, and arguments based on logic,
scientific knowledge, and evidence from data.

SC.PS/BS/ES/ENV/MS/CH/PH/PAH.1.4 Determine the connection(s) among hypotheses, scientific evidence, and
conclusions.

SC.BS/ES/ENV/MS/CH/PH/PAH.1.7 Revise, as needed, conclusions and explanations based on new evidence.

Science Standard 2: Nature of Science: Understand that science, technology, and society are interrelated.

Grade 8 Benchmark for Science:
SC.8.2.2 Describe how scale and mathematical models can be used to support and explain scientific data.

Grades 9—12 Benchmark for Earth & Space Science:
SC.ES.2.4 Describe technologies used to collect information about the universe.

Science Standard 3: Organisms and the Environment: Understand the unity, diversity, and interrelationships of
organisms, including their relationship to cycles of matter and energy in the environment.

Grades 9—12 Benchmarks for Biological Science and Plants and Animals in Hawai'‘i:

SC.BS.3.1 Describe biogeochemical cycles within ecosystems.

SC.PAH.3.1 lllustrate biogeochemical cycles within the Hawaiian ecosystem and describe how abiotic and biotic
influences have impacted these cycles.

SC.PAH.3.3 Explain how matter and energy flow through living systems and the physical environments (e.g., subalpine,
rainforest, montane bogs, dryland and mesic forests, subterranean, freshwater, coastal) found in Hawai‘i.

Science Standard 3: Earth Science: Understand the physical systems of the earth.

Grades 9—12 Benchmarks for Environmental Science:
SC.ENV.3.1 Judge the effects of ocean currents on climate.

Science Standard 3: Oceanography: Understand the physical features of the ocean and its influences on weather and
climate.

Grades 9—12 Benchmarks for Marine Science:

SC.MS.3.3 Explain how the ocean participates in the geochemical cycling of elements.
SC.MS.3.5 Describe how waves and currents move using physical principles.
SC.MS.3.8 Explain how the ocean influences weather and climate.



Science Standard 4: Structure and Function in Organisms: Understand the interconnections of living systems.

Grades 9—12 Benchmarks for Environmental Science:

SC.ENV.4.3 Explain how ecosystems respond to human activities.

SC.ENV.4.6 Describe how the availability of resources (e.g., energy, water, oxygen, minerals) limits the amount of life
an environment can support.

Science Standard 4: Ecological Systems: Understand the locations and characteristics of marine ecosystems.

Grades 9—12 Benchmarks for Marine Science:

SC.MS.4.5 Explain how chemical factors (e.g., pH, salinity, dissolved O,, nutrients) affect the distribution of life in the
ocean.

SC.MS.4.6 Describe how physical factors (e.g., light, temperature, pressure, current) define the region/zone in the
ocean.

Science Standard 5: Diversity, Genetics, and Evolution: Understand genetics and biological evolution and their impact
on the unity and diversity of organisms.

Grade 8 Benchmark for Science:
Benchmark SC.8.5.1 Describe how changes in the physical environment affect the survival of organisms.

Science Standard 8: Earth and Space Science: Understand the Earth and its processes, the solar system, and the
universe and its contents.

Grade 8 Benchmark for Science:

Benchmark SC.8.8.4 Explain how the sun is the major source of energy influencing climate and weather on Earth.
Benchmark SC.8.8.6 Explain the relationship between density and convection currents in the ocean and atmosphere.
Benchmark SC.8.8.7 Describe the physical characteristics of oceans.

Grades 9—12 Benchmarks for Earth and Space Science:

SC.ES.8.1 Describe how elements and water move through solid Earth, the oceans, atmosphere, and living things as
part of geochemical cycles.

SC.ES.8.4 Describe how heat and energy transfer into and out of the atmosphere and their involvement in global
climate.

SC.ES.8.6 Describe how winds and ocean currents are produced on the Earth's surface.

Math Standard 9: Patterns and Functional Relationships: Understand various types of patterns and functional
relationships.

Grades 9—12 Benchmarks for Algebra I:
MA.AL9.2 Compare and contrast the concepts of direct and inverse variation of a relation.

Math Standard 10: Symbolic Representation: Use symbolic forms to represent, model, and analyze mathematical
situations.

Grade 8 Benchmarks for Math:

Benchmark MA.8.10.1 Translate among tables, graphs (including graphing technology when available), and equations
involving linear relationships.

Benchmark MA.8.10.3 Use tables and graphs to represent and compare linear relationships.

Math Standard 11: Fluency with Data: Pose questions and collect, organize, and represent data to answer those
questions.

Grades 9—12 Benchmarks for Statistics:

MA.S.11.1 Develop a hypothesis for an investigation or experiment.

MA.S.11.2 Recognize the variables and controls in an experiment or investigation.

MA.S.11.4 Recognize features of representations of data that can produce misleading interpretations.
MA.S.11.5 Recognize sampling, randomness, bias, and sampling size in data collection and interpretation.



Math Standard 12: Statistics: Interpret data using methods of exploratory data analysis.

Grade 8 Benchmarks for Math:

Benchmark MA.8.12.1 Recognize situations appropriate for scatter plots.

Benchmark MA.8.12.2 Analyze different representations of the same data to describe how representations can be
used to skew a person's interpretation of the data.

Math Standard 13: Data Analysis: Develop and evaluate inferences, predictions, and arguments that are based on
data.

Grade 8 Benchmark for Math:
Benchmark MA.8.13.1 Make conjectures about possible relationships between two characteristics of a sample based
on interpretations of scatter plots.

Content Standards for California Public Schools:
Focus on Physical Sciences
Grade 8 — Standard 8a. Students know density is mass per unit volume.

Investigation and Experimentation

Grade 8 — Standard 9a. Plan and conduct a scientific investigation to test a hypothesis.

Grade 8 — Standard 9e. Construct appropriate graphs from data and develop quantitative statements about the
relationships between variables.

Biology/Life Sciences

Grades 9—12 — Standard 6b. Students know how to analyze changes in an ecosystem resulting from changes in
climate, human activity, introduction of nonnative species, or changes in population size.

Grades 9—12 — Standard 6d. Students know how water, carbon, and nitrogen cycle between abiotic resources and
organic matter in the ecosystem and how oxygen cycles through photosynthesis and respiration.

Earth Sciences

Grades 9—12 — Standard 5a. Students know how differential heating of Earth results in circulation patterns in the
atmosphere and oceans that globally distribute the heat.

Grades 9—12 — Standard 5d. Students know properties of ocean water, such as temperature and salinity, can be used
to explain the layered structure of the oceans, the generation of horizontal and vertical ocean currents, and the
geographic distribution of marine organisms.

Investigation and Experimentation

Grades 9—12 — Standard 1a. Select and use appropriate tools and technology (such as computer-linked probes,
spreadsheets, and graphing calculators) to perform tests, collect data, analyze relationships, and display data.
Grades 9—12 — Standard 1d. Formulate explanations by using logic and evidence.

Algebra |
Grades 8-12 — Standard 24.2. Students identify the hypothesis and conclusion in logical deduction.

State of Oregon Standards by Design:
Interaction and Change

8.2E.3 Explain the causes of patterns of atmospheric and oceanic movement and the effects on weather and
climate.

H.2L.1 Explain how energy and chemical elements pass through systems. Describe how chemical elements are
combined and recombined in different ways as they cycle through the various levels of organization in
biological systems.

H.2E.1 Identify and predict the effect of energy sources, physical forces, and transfer processes that occur in the
Earth system. Describe how matter and energy are cycled between system components over time.



H.2E.4 Evaluate the impact of human activities on environmental quality and the sustainability of Earth systems.
Describe how environmental factors influence resource management.

Scientific Inquiry

8.35.1 Based on observations and science principles, propose questions or hypotheses that can be examined
through scientific investigation. Design and conduct a scientific investigation that uses appropriate tools,
techniques, independent and dependent variables, and controls to collect relevant data.

H.3S.1 Based on observations and science principles, formulate a question or hypothesis that can be investigated
through the collection and analysis of relevant information.

H.3S.2 Design and conduct a controlled experiment, field study, or other investigation to make systematic
observations about the natural world, including the collection of sufficient and appropriate data.

Data Analysis and Algebra

8.2.1 Organize and display data (e.g., histograms, box-and-whisker plots, scatter plots) to pose and answer
questions; and justify the reasonableness of the choice of display.

8.2.3 Interpret and analyze displays of data and descriptive statistics.

8.2.4 Compare descriptive statistics and evaluate how changes in data affect those statistics.

8.2.7 Identify claims based on statistical data and evaluate the reasonableness of those claims.

8.2.8 Use data to estimate the likelihood of future events and evaluate the reasonableness of predictions.

Algebra
H.2A.4 Fluently convert among representations of linear relationships given in the form of a graph of a line, a table

of values, or an equation of a line in slope-intercept and standard form.

H.1S Analysis
H.1S.4 Use or construct a scatter plot for a given data set, determine whether there is a (n) linear, quadratic,

exponential, or no trend. If linear, determine if there is a positive or negative correlation among the data;
and, if appropriate, sketch a line of best fit, and use it to make predictions.

Ocean Literacy Principles. The following ocean literacy principles can be addressed through these lessons:

Ocean Literacy Principle 1: The Earth has one big ocean with many features.

a. The ocean is the dominant physical feature on our planet Earth—covering approximately 70% of the planet’s
surface. There is one ocean with many ocean basins, such as the North Pacific, South Pacific, North Atlantic, South
Atlantic, Indian, and Arctic.

c. Throughout the ocean there is one interconnected circulation system powered by wind, tides, the force of the
Earth’s rotation (Coriolis effect), the Sun, and water density differences. The shape of ocean basins and adjacent
land masses influence the path of circulation.

e. Most of Earth’s water (97%) is in the ocean. Seawater has unique properties: it is saline, its freezing point is
slightly lower than fresh water, its density is slightly higher, its electrical conductivity is much higher, and it is
slightly basic. The salt in seawater comes from eroding land, volcanic emissions, reactions at the seafloor, and
atmospheric deposition.

Ocean Literacy Principle 3: The ocean is a major influence on weather and climate.

a. The ocean controls weather and climate by dominating the Earth’s energy, water, and carbon systems.
The ocean dominates the Earth’s carbon cycle. Half the primary productivity on Earth takes place in the sunlit
layers of the ocean and the ocean absorbs roughly half of all carbon dioxide added to the atmosphere.

f. The ocean has had, and will continue to have, a significant influence on climate.



Ocean Literacy Principle 7: The ocean is largely unexplored.

b. Understanding the ocean is more than a matter of curiosity. Exploration, inquiry, and study are required to better
understand ocean systems and processes.

d. New technologies, sensors, and tools are expanding our ability to explore the ocean. Ocean scientists are relying
more and more on satellites, drifters, buoys, subsea observatories, and unmanned submersibles.

e. Use of mathematical models is now an essential part of ocean sciences. Models help us understand the
complexity of the ocean and of its interaction with Earth’s climate. They process observations and help describe
the interactions among systems.

f.  Ocean exploration is truly interdisciplinary. It requires close collaboration among biologists, chemists,
climatologists, computer programmers, engineers, geologists, meteorologists, physicists, and new ways of
thinking.

References:
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Education and Research: Testing Hypotheses (EARTH) 2008 workshop, held in Corvallis, Oregon
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Garcia, H. E., R. A. Locarnini, T. P. Boyer, and J. I. Antonov, 2006. World Ocean Atlas 2005, Volume 3: Dissolved Oxygen,
Apparent Oxygen Utilization, and Oxygen Saturation. S. Levitus, Ed. NOAA Atlas NESDIS 63, U.S. Government Printing
Office, Washington, D.C., 342 pp. ftp://ftp.nodc.noaa.gov/pub/WOA05/DOC/wo0a05 vol3 text figures.pdf

Hawai‘i Ocean Time-series (HOT) http://hahana.soest.hawaii.edu/hot/hot jgofs.html

NASA (2009) Salt of the earth (mini-documentary about salinity, ocean circulation, and climate)
http://www.youtube.com/watch?v=Har450cWpHE

Texas A&M University’s Ocean World http://oceanworld.tamu.edu/students/currents/currents1.htm




TEACHER SUPPLEMENTAL INFORMATION

One of the most noticeable features of a map, globe, or picture of the Earth is that the oceans cover the vast majority of
the planet’s surface. Most people’s experience with the ocean is confined to the near shore and/or the upper portion of
the water column, and their understanding of the ocean is based on this limited exposure. It is easy to imagine that
below the waves, the ocean acts like a big bow! of stagnant water. This couldn’t be further from the truth! The ocean is
a vast, dynamic environment in constant motion. Waves, swells, tides, and currents move huge quantities of water long
distances. Trying to understand the complexities of all the small-scale movements can seem daunting. However, there
is an overall global circulation pattern that explains the general flow of the ocean. This overall pattern is known as the
ocean conveyor belt and is an extremely important factor in determining climate, the distribution of marine organisms,
and chemical cycles.

To understand ocean dynamics, oceanographers collect water samples from a range of sites and an array of depths.
They measure many factors, including temperature, salinity, dissolved gases, nutrients, and chlorophyll. The
temperature and salinity of seawater determine density and affect how nutrients and gases dissolve. By monitoring
these variables, scientists can establish baselines of ocean features and processes, track how the ocean is changing, and
make predictions of future trends. The lessons in this kit incorporate the variables italicized above to help explain some
large-scale ocean characteristics and circulation patterns. Some background information on these italicized words, as
well as a few additional terms, is provided below.

Temperature
A slight change in water temperature can have a large effect on the density of water and the amount of gases and

particles that can dissolve in water. The density differences caused by changes in temperature can allow water to sink in
water. For example, colder water is denser than warmer water; therefore, cold water tends to sink when added to the
surface of warm water. The relationship between water temperature and density isn’t strictly linear, however. The
density of water increases with decreasing temperature until the water temperature reaches 4°C; this is the
temperature at which water is densest. As water continues to cool below 4°C, the density begins to decrease. In this kit,
we use the simplification that cold water is denser than warm water and set aside the finer details.

Salinity

Seawater is composed of 96.5% pure water and 3.5% other materials, such as salts, dissolved gases, organic and
inorganic materials, and suspended particles. Salinity is the measure of the amount of dissolved salts in seawater. The
most well known salt is table salt (sodium chloride, or NaCl). Most of the salt in the ocean is NaCl (86%), but there are
numerous other salts in seawater. The major components that make the ocean salty are sodium (Na®), chloride (CI),
magnesium (Mg,"), sulfate (50,>), calcium (Ca**), and potassium (K*). These ions make up 99% of the materials that
make seawater salty. The remaining 1% consists of a number of varying trace elements. The really interesting thing
about the major ions is that they are always found in the same ratio to each other no matter where in the open ocean
the water is sampled. The constancy of this ratio allows for easier measurements of salinity.

There are several different units for salinity. Historically, salinity was defined as the sum of all dissolved salts found in
seawater expressed in g/kg. The average seawater salinity is 35 g/kg which means that for every kg of seawater, there
are 35 g of salts. Salinity can also be expressed in parts per thousand (ppt): 35 g of salt per 1000 g of seawater means
that 35 out of 1000 parts water are salts (35 ppt). Salinity can also be inferred. Scientists discovered that the
conductivity of seawater is directly related to salinity. Conductivity is a measure of how well a substance can carry an
electrical current: the saltier the water, the more conductive it is. The units of salinity are interchangeable, so salinities
of 35 ppt and 35 g/kg are equivalent. Practical salinity units (psu) can also be used to represent salinity: 35 psu is
equivalent to 35 ppt and 35 g/kg.

Density
Water in the ocean is stratified (layered). The layers occur due to differences in density, which is defined as mass per

unit volume. Temperature and salinity are the major variables that determine the density of seawater. Cold, salty water
is denser than warm, fresh water. One liter of seawater weighs about 1.025 kg (2.25 Ibs) whereas one liter of freshwater
weighs about 1.000 kg (2.20 Ibs).



Pressure is another factor that affects density; deeper water is slightly denser due to the weight of the water above.
Small horizontal differences in density set up strong currents, and changes in surface water density near the poles are
responsible for initiating the ocean conveyor belt.

Dissolved Gases

Seawater contains small amounts of dissolved gases: many of these gases originated in the atmosphere and got mixed
into the water at the surface by waves and wind. The gases that are most important to oceanographers are oxygen (0O,)
and carbon dioxide (CO,) because of their roles in regulating respiration, photosynthesis, and climate. Phytoplankton
and marine algae produce O, through photosynthesis and can be thought of as “the plants of the sea”. Other organisms
such as zooplankton and fish consume O, and expel CO,.

Dissolved oxygen in the ocean comes from two processes: it is generated by photosynthetic marine and terrestrial
organisms, and is mixed into the ocean through interactions with the atmosphere. Both of these processes only occur
within the surface layer, where water contacts the atmosphere and where there is enough light for photosynthesis.
Below about 200 m, no new oxygen is added to the water; instead it is only utilized in respiration and decomposition.

The “age” of seawater, defined as the amount of time the seawater has been out of contact with the surface layer, can
be calculated by measuring oxygen concentrations. The clock starts when the water sinks below the surface layer: once
it is below this layer, no new oxygen can be added. The longer a water mass remains below the surface layer, the more
time organisms have to consume oxygen, and the concentration of dissolved oxygen becomes lower. Therefore, the
“older” the water, the lower the concentration of dissolved oxygen. This concept of the “age” of water is discussed in
Lesson 4: Nutrients and Ocean Circulation.

Nutrients

Nutrients are substances that an organism must obtain from its surroundings for growth and survival. In the ocean,
nutrients for phytoplankton and algae consist of organic and inorganic compounds. The most common nutrients
measured are phosphorus (P) and nitrogen (N). Phosphorus is an important component of DNA, ATP, and cell
membranes. Nitrogen is an important component of DNA, proteins, and enzymes. The topic of nutrients is discussed in
Lesson 3: Using Data to Explore Ocean Processes and Lesson 4: Nutrients and Ocean Circulation.

Chlorophyll
Chlorophyll is a common pigment that allows plants to take energy from the sun and produce carbohydrates. Most of

the primary producers in the ocean are microscopic phytoplankton, and chlorophyll measurements are a quick way to
estimate their abundance. The greater the concentration of chlorophyll, the larger the number of photosynthetic
organisms present. In vertical profiles of chlorophyll, the maximum chlorophyll peak occurs at depth. This deep
chlorophyll maximum could indicate a higher abundance of photosynthetic organisms or greater chlorophyll content in
phytoplankton living in a darker environment.

Depth and Pressure
Oceanographers study the ocean three-dimensionally. Therefore, they need to know where the samples were collected

geographically and from what depth. The surface measurements are based on the geographical coordinate system,
latitude and longitude. Depth is always measured from the surface downwards, and the surface is considered the zero
point. The simplest way to measure depth is to use a piece of rope with measured markings, tie a weight on the end,
lower the weight into the water, and read the depth from the markings. However, this method is rarely precise,
accurate, or practical (think about measuring 2000m from a swaying boat), so depth is usually measured indirectly by
measuring pressure.

Pressure increases as you go deeper into the ocean because of the weight of the overlying water. Ten meters (10 m) of
seawater is equivalent to 1 bar of pressure, therefore 1 m of seawater is equivalent to 1 decibar (dbar). Graphs of
vertical oceanographic data are plotted with pressure in dbar on the y-axis and one (or more) of the variables discussed
above on the x-axis. Pressure (dbar) is converted to depth (m) because they are equivalent and it is easier to
conceptualize data in terms of depth. Graphs from Lesson 4: Nutrients and Ocean Circulation use depth (m) on the y-
axis.



TEACHER GUIDE
Lesson 1: Water Stratification

Time Required: 70 minutes. Allot at least 30 minutes for advance preparation the day before the lesson, and an
additional 45 minutes on the day of instruction.

Structure: Students will learn how temperature and salinity affect density by creating stratified water systems. Upon
entering the class, they will find an example of a stratified water system and will work small groups to recreate the
example after a brief introduction. The teacher will then lead the entire class in experiments to further investigate the
effects of temperature and salinity on density. The lesson concludes with the PowerPoint presentation entitled, Lesson
1_Water Stratification, which relates the experiment to the world’s oceans and introduces the students to the concept
of a layered ocean. A combined pre- and post- survey is included for Lessons 1 and 2 (the pre-survey is given at the
beginning of Lesson 1 and the post-survey is given at the end of Lesson 2).

Materials: (Paper materials contained in binder are shown in BOLD CAPS)
Materials are provided for students to work in 7 groups. We recommend 4-5 students per group.
1. OCEAN CONVEYOR BELT SURVEY - Lessons 1 and 2
TEACHER ANSWER KEY to OCEAN CONVEYOR BELT SURVEY — Lessons 1 and 2
MATERIALS PHOTO GUIDE - Lesson 1: Water Stratification (Teacher Supplies)
MATERIALS PHOTO GUIDE - Lesson 1: Water Stratification (Water Containers and Student Supplies)
HOT WATER DISPENSER GUIDE - Lesson 1: Water Stratification
SALINITY METER GUIDE — Lesson 1: Water Stratification
SALINITY APPROXIMATION TABLE - Lesson 1: Water Stratification
Color-coded GROUP EXPERIMENT cards (8)
STUDENT WORKSHEET - Lesson 1: Water Stratification
. TEACHER ANSWER KEY to STUDENT WORKSHEET — Lesson 1: Water Stratification
. POWERPOINT SCRIPT — Lesson 1: Water Stratification
. GLOSSARY
. CD with narrated PowerPoint presentations
. Manuals for Hot Water Dispenser and Salinity Meter
. Large plastic tanks with bottom and one side painted white (3)
. Clip-on labels for tanks during group experiments (2)
. One large plastic resealable bag containing:
0 Wooden blocks (3)
1500 ml Measuring Bottle (1)
1000 ml Demonstration Water bottle (1)
250 ml beakers (4)
100 ml beakers (2)
Probe Rinse Water beaker (1)
Measuring spoon sets (% tsp, % tsp, 1 tsp) (2)
Plastic spoons (2)
Small salt container (1)
0 4 colors of food dye: Red, Yellow, Green, and Blue (2 each)
18. Oakton SALT 6 hand-held salinity meter (1)
19. Small plastic tanks (7)
20. Small plastic re-sealable bags (7), each containing:
0 Wooden block (1)
100 ml beaker (1)
Measuring spoon set (% tsp, ¥ tsp, 1 tsp) (1)
Plastic spoon (1)
Small container filled with ~ % cup of salt (1)
0 2 colors of food dye: Red and Blue (1 each)
21. Hot water dispenser with power cord
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22
23
24
25

. Red cooler

. Collapsible water carrier

. Extra salt for refilling small containers
. Speakers

Materials Not Included in the Kit but Needed for Lesson 1:

26
27
28
29
30

. Water

. Ice (enough to fill red cooler)

. Paper towels

. Computer with PowerPoint software and a CD drive
. Projector

Advance Preparation:
Review lesson and gather materials (These steps need to be done the day before the lesson; 30 minutes.)

1.

2.

3.

10.

Watch the example tank set-up video on CD for a demonstration on how to make the example tank.
Practice making the example tank! (See instructions on the following pages.)
Make sure that you will have enough ice to fill the red cooler (about one 7 pound bag).

Make sure that you will have access to water. A collapsible water carrier is included in case you do not have a
faucet in your classroom. However, try to borrow a large cooler or drink dispenser for your tap water if you do
not have a faucet, as the collapsible water carrier is prone to leaking.

Two PowerPoint presentations for Lesson 1 are located on the CD. One of these PowerPoint presentations,
entitled Lesson 1_Worksheet Template, contains the tables and graphs on STUDENT WORKSHEET - Lesson 1:
Water Stratification. This can be projected onto a whiteboard so that it can be filled out during the group
experiments. The other is a short, narrated PowerPoint presentation entitled Lesson 1_Water
Stratification_NARRATED which will be shown after the experiments to relate them to ocean structure. Load
both PowerPoint presentations onto your computer by dragging the files from the CD onto your computer
desktop.

Speakers are included in the kit for playing the narrated presentation. Refer to the laminated manual attached
to the speaker storage case for set-up instructions.

If you prefer to present the information yourself, load the non-narrated version, Lesson 1_ Water
Stratification_NON-NARRATED. POWERPOINT SCRIPT - Lesson 1: Water Stratification is included as a guide.

Once the presentations have been loaded, eject the CD and return it to the binder.

Photocopy or print the OCEAN CONVEYOR BELT SURVEY — Lessons 1 and 2 (one per student). This is given as a
pre-survey at the beginning of this lesson. It will also be given as a post-survey at the end of Lesson 2.

Photocopy or print the STUDENT WORKSHEET — Lesson 1: Water Stratification and GLOSSARY (one of each per
student). The GLOSSARY is pertinent for all lessons in this kit and can be found in the GLOSSARY tab.

Prepare supplies (45 minutes on the day of instruction; includes setting up example tank, the demonstration tank, and
setting out the materials for the group experiments)

1.

Set up a water station where students will be able to access hot, cold, and tap water. Note: The greater the
difference in temperature, the better the chance of layering.
a. Hot Water (See HOT WATER DISPENSER GUIDE for details)
1. Do not plug in hot water dispenser before adding water. Fill hot water dispenser to full line.
IMPORTANT: Control panel cannot get wet. Do not fill directly from faucet. Rinse the
Measuring Bottle and use it to add water.




2. Close the lid securely. Make sure you hear a “click” when closing.

3. Plug in the unit to turn the power on; it takes about 30—40 minutes to heat completely.

4. Push temp set button until the green indicator light is set to 140°F. The light will blink while
heating.

5. Unit will begin to heat water and beep 9 times when complete. Green indicator light will blink
until the water cools to 140°F and will stay a steady green when it is in “keep warm” mode. You
can dispense water at any time.

Note: Heater will boil water first and then cool to 140°F so it may be extremely hot for your first
class. Itis about the same temperature as a fresh cup of coffee or tea so inform your students to
be careful to avoid burns.

b. Cold Water

1. Fill the cooler with ice (about one standard size bag of ice), but leave room to secure the lid.
2. Fill the cooler with tap water and secure the lid.

c. Tap Water

1. If you have a faucet in your room, have the students use that for the tap water in the
experiments. If not, fill the collapsible water carrier to dispense tap water (CAUTION: Carrier
will weigh ~ 40 Ibs when full).

Note: If you do not have a faucet, try borrowing a large cooler or drink dispenser for your tap
water, as the collapsible water carrier is prone to leaking. Alternatively, conduct Lesson 1
outside, but be sure to discard the salty water down a drain and not on plants, as salty water
may kill plants.

2. Set up materials for student lab stations. Each lab station should have:
a. Small plastic tank (1)
b. One plastic re-sealable bag containing the following:

(0]
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Wooden block (1)

100 ml beaker (1)

Measuring spoon set (% tsp, ¥ tsp, 1 tsp) (1)
Plastic spoon (1)

Small container filled with ~ % cup of salt (1)
2 colors of food dye: Red and Blue (1 each)

3. Set up the example tank, the demonstration tank, and set out the materials for the group experiments. The
example tank is a stratified water system that is used to pique the students’ curiosity, and is used as a reference
throughout the day. The demonstration tank is used to show the pouring technique to the students and is then
used again, in addition to the third painted tank, during the group experiments. The tanks should be located on
a table or lab bench where students can easily see the long side of the tank. For the example, demonstration,
and group experiments, you will need:

a. Large plastic tanks with bottom and one side painted white (3)
b. Clip-on labels for tanks during group experiments (2)
c. One large plastic re-sealable bag containing the following:

0]
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Wooden blocks (3)

1500 ml Measuring Bottle (1)

1000 ml Demonstration Water bottle (1)

250 ml beakers (4)

100 ml beakers (2)

Probe Rinse Water beaker (1)

Measuring spoon sets (% tsp, % tsp, 1 tsp) (2)

Plastic spoons (2)

Small salt container (1)

4 colors of food dye: Red, Yellow, Green, and Blue (2 each)

d. Oakton SALT 6 hand-held salinity meter (1)



4.

e. Color-coded GROUP EXPERIMENT cards (8)

Make demonstration water
a. Fill bottle labeled Demonstration Water with 1000 ml tap water.
b. Add 2 tsp of salt to the bottle.
c. Secure lid and shake until salt is dissolved.

Set up example tank (This is only done once; 20 minutes.)

1.

10.

11.

12.

Follow the directions below to set up a tank with three differently colored water layers (Figure 1). The way the
different waters are added is extremely important, as excess
agitation will cause the waters to mix and prevent stratification.

Choose a location where the tank will not be disturbed and ‘
where the students will notice the tank as they enter the

classroom. DO NOT MOVE THE EXAMPLE TANK ONCE IT IS SET

UP. The system is stable enough that it will maintain the three

layers for the day as long as it is not disturbed; however, sudden ﬁ

movement or a sustained breeze may mix the layers. If left

overnight, the system tends to break down into two layers. Thisis  Figure 1. Finished example tank with a
OK for Lesson 2, but you will need to make a new example tank
each day you conduct Lesson 1.

layered water system.

Place a wooden block under the edge of one of the plastic tanks (Figure 1).

Fill the Measuring Bottle with 1400 ml of tap water (line marked on bottle).

Add 1 tsp of salt to the bottle and shake until dissolved.

Pour the salty water from the Measuring Bottle into the example tank. After pouring, 1-2 inches of the bottom
of the tank will remain uncovered. You will pour the colored water samples in the subsequent steps onto this

exposed plastic area.

ST
Use a beaker to measure 100 ml of cold water. ai -\’l

Add 1 tsp of salt to the cold water and stir with a plastic spoon %\

until the salt is dissolved.
Add 3—4 drops of BLUE food dye and stir. e ?

Slowly pour the cold, salty, blue water onto the exposed plastic
part of the tank. Be careful not to disturb the water already in Figure 2. Pouring the cold, salty blue
the tank with the beaker (Figure 2). water into the tank.

Use a beaker to measure 200 ml of hot water (tap water can be used if hot water is not yet ready).

Add 4-5 drops of RED food dye and stir.



13. Slowly pour the hot, fresh, red water onto the exposed plastic

part of the container. Be careful not to disturb the water that is
already in the tank with the beaker (Figure 3).

Set up demonstration tank (This needs to be done prior to each class

and is used to show the students how to add the dye and pour the
water; 10 minutes.)
1.

Start by placing one wooden block under the edge of one of the
large, painted tanks.

Figure 3. Pouring the hot, fresh, red water

Place a 250 ml beaker, food dye, plastic spoon, and the into the example tank.

Demonstration Water bottle (filled according to step 6 of
Prepare Supplies) near the tank.

Fill the Measuring Bottle (to the line) with 1400 ml of tap water and pour it into the demonstration tank.

Set up group experiment station (15 minutes)

1.

Place one wooden block under the edge of the remaining large, painted tank. The demonstration tank will be
used for the other group experiment tank.

Set out 100 ml beakers (2), 250 ml beakers (4), measuring spoon sets (2), the small salt container, plastic stirring
spoons (2), food dye (4 colors), the salinity meter, and the Probe Rinse Water beaker filled about half full with
fresh water.

Project the Lesson 1_Worksheet Template PowerPoint presentation onto a chalkboard or dry-erase board so
that the table and graphs can be filled out during the experiments.

Instructional Procedures:
Administer the Pre-Survey

Distribute the OCEAN CONVEYOR BELT SURVEY - Lessons 1 and 2 (one per student). Have students check the pre-
survey box and answer the questions (allow 5—10 minutes). After Lesson 2 is completed, the students will answer these
same questions as a post-survey. A TEACHER ANSWER KEY is provided for your convenience.

Demonstration and Challenge

1.

3.

If the students have not asked about the 3-layered example tank yet, introduce it now as a challenge for the
students. Explain that you made the example using the different types of water at the water station and the
supplies found at the lab stations. After a few simple instructions (below), each student group gets 10 minutes
to try to duplicate the example set-up.

Go over the following tips and tricks to help the students:
a. Any additives must be well mixed and completely dissolved. The salt at the lab stations should last for
all classes.
b. The way the water is added makes a big difference in stratification. It is important to pour slowly and
carefully onto the bare plastic.
c. Water in the tank needs to be as stable as possible; excess mixing while adding water will prevent layers
from forming.
d. Only use two drops of food dye.
e. Look through the tank from the side.
f.  Always use tap water for your starting volume of water as the supply of hot and cold water is limited.
Demonstrate how to pour the water.
a. Inform the students that the demonstration tank is filled with 1400 ml of tap water.



4.

5.

6.

7.

b. Pour approximately 200 ml of the Demonstration Water into a beaker and tell the students that it
contains an ingredient from one of their lab supplies.

c. Add 2-3 drops of food dye to the beaker and reiterate that the students do not need to add any more
dye than this because something other than the dye causes the layering.

d. Demonstrate how to pour the water into the tank by pouring the water slowly onto the exposed slope
of the container. Have the students closely watch what happens. Ask them to describe what they
observe. (To prepare for the group experiments, you can empty out this tank while the students are
working.)

Discuss how to use the hot water dispenser and other safety issues.

a. The water may be the temperature of a fresh cup of hot tea and has the potential to cause burns.

b. Leave temperature set to 140°F.

c. Only dispense water into your beaker, and hold the beaker directly under the spout.

d. To dispense water, the unit needs to be unlocked. The unit is unlocked when you see a red indictor light
next to the unlock button. If the light is off, press the Unlock button once.

e. Press and hold the Dispense button to dispense water. Stop pushing Dispense when the desired water
level is reached. Note: Water will continue to be dispensed for a few seconds after you let go, so stop a
little early.

Distribute the STUDENT WORKSHEET - Lesson 1: Water Stratification and give the students 10 minutes to try
and create their own 3-layered system using the supplies at their lab stations and the worksheet as a guide.
Instruct students to clean up their lab stations after they have completed the challenge. If your class time is
limited and one or more groups finish before the others, start the successful students on step two of the group
experiment instructions below.

After ten minutes of open experimentation, lead a class discussion about the groups’ attempts and their results.
Stress that any groups that were unable to produce layers did not fail; they just discovered what does not work.
Record the different group results on the board and see if any patterns emerge.

Questions to help lead discussion:
a. What factor(s) caused layers to form?
b. Was it just one factor or a combination of factors?
c. There are two variables that influence the formation of layers: temperature and salinity. How could you
devise a controlled experiment to see how each factor separately influences layering?

Group Experiments

1.

Lead the students through two experiments testing the effects of: 1) salinity on water stratification, and 2)
temperature on water stratification. If you have time, guide the students through inquiry experiments testing
temperature and salinity as a class. If you have enough hot and cold water for your classes, have the students
design the experiments in small groups. Measure the temperature of the hot, cold, and tap water once for the
class, and assume that the temperature will not change during the class. Show the students how to measure
salinity using the salinity meter and give them the SALINITY APPROXIMATION TABLE to use for their
experiments. If you are short on time, use the following instructions for a structured group experiment testing
temperature and salinity.

In order to reduce the amount of time it takes to run the group experiments, hand out the Group Experiment 1:
Testing variations in salinity and the Group Experiment 2: Testing variations in temperature cards to the
students who complete their 3-layered tank challenge first. Instruct these students to follow the directions on
their card and tell them they are responsible for this part of the group experiment. Show them how to use the
salinity meter (probe) to measure salinity and temperature and have them record these values on a datasheet.
See the SALINITY METER GUIDE for directions on how to use the probe.



Tip: If you have a large number of students, then divide the class in two. Have half of the class sit in chairs around the
group tanks while the other group stands behind them, and reverse the two groups for the second group experiment.

Group Experiment 1: Testing variations in salinity

1.

During the experiment, complete the salinity data collection table and blank graph from the Lesson

1 Worksheet Template PowerPoint presentation that is projected onto the board. The table and graph are the
same as those in the STUDENT WORKSHEET — Lesson 1: Water Stratification. Clip the corresponding label onto
the tank.

Hand out the Group Experiment 1: Testing variations in salinity cards: “Water 1”, “Water 2”7, and “Water 3” to
three students and have them make the different water types as instructed on the cards.

After “Water 1” has been poured into the tank labeled Group Experiment 1, have the students predict what will
happen when the GREEN “Water 2” is poured into the tank.

Have a student carefully pour the salty, GREEN water into the tank, standing so that other students can see what
happens.

The saltier green water should flow under the clear water. Point out that it moves slowly, as a front plowing
under the clear water. What happens when it hits the side of the container? Green water may flow up and
mix with the clear water. Light refraction and/or reflection may also tint the clear water green (Figure 4).

Have the students predict what will happen when the . ??
RED “Water 3” is poured into the tank.

Have a student carefully pour the RED, salty water into q
the tank, standing so that other students can see what

happens.

The red water with a salinity intermediate between 3
the green and clear water should flow under the clear m
water and form a layer between the clear and green
water (Figure 5). There may be some mixing near
where the water is poured in and the red water may
“push” the green water out of the way where they
first interact. You may also notice an internal wave
form as the red water flows between the two layers.

Figure 4. The Group Experiment 1 tank with
waters 1 and 2 added.

Lead the students through graphing salinity using the ’
Lesson 1_Worksheet Template PowerPoint
presentation.

Example of completed data table and graph are found :
on the TEACHER ANSWER KEY to STUDENT “
WORKSHEET - Lesson 1: Water Stratification. Actual

values will vary from the samples found on the answer

Figure 5. The Group Experiment 1 tank with
sheet.

waters 1, 2, and 3 added.

Leave this tank set up and transition to the temperature experiment.

Group Experiment 2: Testing variations in temperature

1.

Advance to slide 2 in the PowerPoint presentation entitled, Lesson 1_Worksheet Template and complete the
temperature data table and graph during the experiment. Clip the corresponding label onto the tank.



If have not already done so, hand out the Group Experiment 2: Testing variations in temperature cards: “Water
A”, “Water B”, and “Water C” to three different students now and have them make the different water types as
instructed on the cards.

Note: It is important that there is a great enough difference in temperature for layers to form. Cold water should
feel cold and hot water should feel hot. If the temperature of these waters has changed too much, have the
students get new water, but use the original temperature measurements.

After “Water A” has been poured into the tank labeled Group Experiment 2, have the students predict what will
happen when the BLUE “Water B” is poured into the tank.

Have a student carefully pour the cold, BLUE water into the tank, standing so that other students can see what
happens.

The cold, blue water should flow under the clear tap water. It will probably flow much more slowly than the
higher salinity green water did in Group Experiment 1. Because of the very fine differences in density
between the different temperature waters, mixing is more likely. The volume of cold water is low (100 ml)
because less water reduces the likelihood of mixing.

Have the students predict what will happen when the RED “Water C” is poured into the tank.

Have a student carefully pour the hot, RED water into the tank, standing so that other students can see what
happens.

The hot, red water should slowly spread out on top of the clear layer. How the water will flow depends on
how it is poured. Looking from the top there will probably be lobes where the water tends to follow the same
path. Have the student pouring describe the view from the top to the class.

Have the students graph the temperature data on their own, using the same graphing format as the salinity
data. An example of a completed data table and graph are found on the TEACHER ANSWER KEY to STUDENT
WORKSHEET - Lesson 1: Water Stratification. Actual values will vary from the samples found on the answer
sheet.

Leave this tank set up and transition to the combination experiment. Be sure that the students finish their
graphs prior to moving on to the next step.

Combination Experiment:

1.

So far, we have tested the individual effects of temperature and salinity on water stratification to create three
distinct water layers in two different tanks. Can we make additional combinations that create a fourth layer?

Pass out the BLUE “Water 4” and RED “Water D” cards to two different students and have them follow the
directions on the cards. Discuss as a class what variables have changed for the combination experiment and
have them make predictions about what will happen when each type of water is added.

Have the students predict what will happen when the YELLOW ”Water D” is added to the Group Experiment 2
temperature-layered tank. You may want to remind them that in Group Experiment 2, the salinity was constant
and stratification occurred due to differences in temperature.

Have a student carefully pour the salty, YELLOW water into the tank, standing in such a way to allow other
students to see what happens.

The yellow, salty water should flow under all of the layers in the tank and form a new bottom layer (no figure
provided). The small volume of yellow water limits the amount of mixing that occurs. Note that “Water D”
cannot be plotted on the temperature vs. depth graph because this graph assumes constant salinity. A three-
axis plot would be necessary to graph waters where both temperature and salinity vary (Figure 7).



5.

Have the students predict what will happen when the BLUE “Water 4” is added to the Group Experiment 1
saline-layered tank. You may want to remind -

them that in Group Experiment 1, the - e
temperature was constant and stratification

occurred due to differences in salinity.

Have a student carefully pour the BLUE, cold,

fresh water into the tank, standing so that Water 4

other students can see what happens. Water 1

The blue, cold, fresh water should slowly Water 3

spread out over the clear, salty layer (Figure Water 2———»

6). How the water flows will depend on how

it is poured. You might see some areas where Figure 6. The Group Experiment 1 tank with
the blue layer is thicker as it forms “pools” in waters 1, 2, 3, and 4 added.

the salty water. This demonstration is

analogous to a river flowing into the ocean or to melting ice sheets. Note that “Water 4” cannot be plotted on
the salinity vs. depth graph because this graph assumes constant temperature. A three-axis plot would be
necessary to properly graph additional waters because both temperature and salinity vary (Figure 7).

Discuss that “Water D” and “Water 4” cannot be plotted with the rest of the waters in the experiments because

two variables, temperature and salinity, change for “Water D” and “Water 4”. A three-axis plot that accounts
for depth, temperature, and salinity is necessary to graph a system where both temperature and salinity vary

(Figure 7).
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Figure 7. A three-axis plot which incorporates a third variable, salinity. The plot on the left shows how the graph
of temperature versus depth may look when plotting “Waters A, B, and C” during Group Experiment 2. The plot
on the right shows how a third axis for salinity is necessary to plot “Water D” (yellow dot) which has a unique
temperature and salinity.

Discuss answers to the last question on the STUDENT WORKSHEET — Lesson 1: Water Stratification: “Where
else might you find systems that are stratified like this?” The ocean, lakes, ponds, and some salad dressings
can be stratified. Discuss the fact that the layers form due to differences in density.

Return to the example tank that was set up prior to class and explain that it can serve as a model of the ocean.

a. The top red layer represents the surface of the ocean. Surface temperature and salinity vary greatly
depending on region. Surface water is colder near the poles and warmer in the tropics. Surface salinity
is lower near rivers and higher where there is greater evaporation.

b. The clear layer represents a transition zone where there are distinct changes in temperature, salinity
and density.

c. The bottom blue layer represents the deep ocean which is typically cold, dark, and more saline. This
layer takes up the greatest volume of the ocean. The temperature of the deep ocean is a relatively
constant 4°C across the globe.



10. Play the narrated PowerPoint presentation, Lesson 1_Water Stratification_NARRATED, to relate the water layers

in the tanks to ocean structure.

11. Time permitting, allow the students to go back to their lab stations and experiment with different combinations

of temperature and salinity. Challenge them to see if they can make their own four-layer systems.

Clean-up:

1.

The salty water from Lesson 1 should be dumped down the drain and NOT onto the ground because its high
salinity may harm some plants.

All of the tanks, beakers, bottles, and stirring spoons should be rinsed with fresh water and allowed to dry
before stacking or sealing in bags.

The hot water heater and cooler should be emptied and allowed to dry completely.
Rinse the probe of the salinity meter with fresh water.

If you plan on completing additional lessons from this kit, please do not have students complete the post-survey
(this will be done after Lesson 2) and do not complete the TEACHER EVALUATION at this time.

If you are not completing additional lessons:

e Please have students complete the post-survey (you will need to make one additional photocopy per
student). As the students are completing the post-survey, we would be grateful if you would complete
the TEACHER EVALUATION of this kit. All comments, corrections, and suggestions are very welcome. If
you prefer, you can complete the evaluation online (see TEACHER EVALUATION for website address).

e Re-pack the kit for return to C-MORE. Double check that all the items are included and in their proper
place by completing the SUPPLY CHECKLIST. Please make a note of missing, broken, or damaged items
so that they can be replaced. Please pack the kit so that the materials are stored as they were when you
received them. Please also include a copy of the students' pre- and post- surveys.

Mahalo!



30 minutes I. Watch video on how to make the example tank and practice making it!
(day before): 1. Make sure that you will have sufficient water.
IIl. Obtain enough ice to fill the red cooler in the morning.
IV. Photocopy OCEAN CONVEYOR BELT SURVEY, STUDENT WORKSHEET and GLOSSARY.
45 minutes I. Set up water station with HOT, COLD, and TAP water.
(day of): Il. Set up large water tanks and make example tank.

lll. Set up student lab stations.
IV. Make “demonstration water” and set up first demonstration.

~70 minutes: After completing the pre-test, students work in groups to reproduce a layered water system and
experiment with the physical properties that affect water density. The lesson ends with the PowerPoint presentation,
Lesson 1_Water Stratification which relates the experiment to the oceans.

10-15 minutes: |. Each student completes and turns in the OCEAN CONVEYOR BELT SURVEY - Lessons 1 and 2.

. Introduce the example tank to the students and challenge them to make their own layered water
system using the supplies at their lab station.

[Il. Tell the students only add a few drops of food coloring and demonstrate how to pour the water.

IV. Go over tips and tricks, how to use the hot water dispensers, and lab safety.

10-15 minutes: |. Students experiment trying to make their own layered water system.

IIl. Lead group discussion about trials and results. Record different group results on the board and
see if any patterns emerge. Transition to group experiments testing temperature and salinity
independently.

20-25 minutes: Lead the students through group experiments 1 and 2. Use the directions provided or have the class

design their own tests varying only temperature or only salinity. Measure, record, and plot
temperature and salinity data. Use the Lesson 1_Worksheet template PowerPoint presentation as

a guide for recording and graphing data.
Water 1: 1400 ml tap water, 1 tsp salt, CLEAR Water A: 1400 ml tap water, CLEAR
Water 2: 200 ml tap water, 1 tsp salt, GREEN Water B: 100 ml COLD water, BLUE
Water 3: 200 ml tap water, % tsp salt, RED Water C: 200 ml HOT water, RED

Combination experiment: What happens when cold, fresh water is added to the saline-stratified tank?
What happens when saline water is added to the temperature-stratified tank?

Water 4: 200 ml COLD water, BLUE Water D: 50 ml tap water, 1 tsp salt, YELLOW

If time permits: Allow the students to go back to their lab stations and experiment with different temperature and

salinity combinations. Challenge them to make a 4-layered tank.

10 minutes: Narrated PowerPoint presentation relates tank experiments to ocean structure.

5-10 minutes: Group reflection on experiments and clean-up.




OCEAN CONVEYOR BELT SURVEY — LESSONS 1 and 2

Check one:
Pre-survey Name:

Post-survey
Directions:
This survey is both a pre- and post- survey. Put a check mark at the top of this paper next to the survey you are doing

(pre- or post- survey). Please answer each question to the best of your ability. Circle the most correct answer.

1. Deep ocean currents are driven by

a. tides
b. density
c. wind
d. boats

2. Ingeneral, the oceans are
a. pretty much the same from the surface to the bottom
b. stratified into two distinct layers
c. separated into different disconnected basins such as the Atlantic, Pacific, and Indian oceans

3. Water can sink in water.
a. True
b. False

4. Circulation in the Atlantic Ocean causes the climate in Western Europe to be
a. afew degrees warmer
b. afew degrees colder
c. unchanged

5. Cold water is than hot water.
a. lighter
b. saltier
c. denser
d. less dense

6. The oceans affect climate by
a. exchanging heat and gases with the atmosphere

transferring heat from the equator to the poles

acting as a sink for carbon dioxide (CO;)

all of the above

none of the above

®oo o

7. CTD stands for Conductivity, Temperature, and Depth. Conductivity is measured to

determine
a. pressure
b. nutrients
c. oxygen
d. salinity



TEACHER ANSWER KEY
OCEAN CONVEYOR BELT SURVEY — LESSONS 1 and 2

Email kits@soest.hawaii.edu to request a

Check one:
Pre-survey completed teacher answer key. Please Name:

Post-survey include name, school and grade(s) taught in

your request. Mahalo!
Directions:
This survey is both a pre- and post- survey. Put a check mark at the top of this paper next to the survey you are doing
(pre- or post- survey). Please answer each question to the best of your ability. Circle the most correct answer.

1. Deep ocean currents are driven by

a. tides
b. density
c. wind
d. boats

2. Ingeneral, the oceans are
a. pretty much the same from the surface to the bottom
b. stratified into two distinct layers
c. separated into different disconnected basins such as the Atlantic, Pacific, and Indian oceans

3. Water can sink in water.
a. True
b. False

4. Circulation in the Atlantic Ocean causes the climate in Western Europe to be
a. afew degrees warmer
b. afew degrees colder
c. unchanged

5. Cold water s than hot water.
a. lighter
b. saltier
c. denser
d. less dense

6. The oceans affect climate by
a. exchanging heat and gases with the atmosphere

transferring heat from the equator to the poles

acting as a sink for carbon dioxide (CO;)

all of the above

none of the above

®oo o

7. CTD stands for Conductivity, Temperature, and Depth. Conductivity is measured to determine

a. pressure
b. nutrients
c. oxygen
d. salinity



MATERIALS PHOTO GUIDE

Lesson 1: Water Stratification (Teacher Supplies)

Salinity Meter (1)

1500 ml Measuring Bottle (1)

1000 ml Demonstration Water
bottle (1)

Large tanks, partially painted
white (3)

Wooden blocks (3)

Plastic spoons (2)

100 ml beaker (1)

e -]

NALGENE*

N

250 ml beakers (2)

Measuring spoon sets (2)

Salt carton (1)
Small salt container (1)

Probe Rinse Water beaker (1)

Food dye: Red, Yellow, Blue,
Green (2 each)




MATERIALS PHOTO GUIDE

Lesson 1: Water Stratification (Water Containers and Student Supplies)

Water containers

Red cooler

Collapsible water carrier

Supplies for student lab stations

Small student tank (1)

Each station will have 1 student
tank and 1 student supply bag filled
with the contents below:

Measuring spoon set (1)

-

Plastic stirring spoon (1)

Wooden block (1)

Small salt container (1)

Food dye: Red (1), Blue (1)




HOT WATER DISPENSER GUIDE
Lesson 1: Water Stratification

The hot water pot included with the kit is intended to provide hot water throughout the day. Simple set-up and
operation instructions are given below. Please see the manufacturer’s Instruction Manual in the back of the kit binder

for detailed operational instructions and important safeguards.

Parts Identification:

Release latch

Steam outlet (to remove lid)
N\ / FULL line
< 4
Latch 3
(to open lid) Handle
Power plug
connection

Water spout

Control panel 7 8
Water level } 7
Temperature |nd|cators(green) Auto cool indicator(green) indicator rf
0
erii Boil %
Dry-boil indicator(red) 194:F“0°F o ,/é’
176°F Unlock indicator(red) f;
it
Boil indicator(red) Te i é;
sel ebm ﬁ
/‘
Z
Safety Precautions: DO NOT let water level =

fall below red indicator

e Do not plug in an empty pot.

e If Dry-boil light is on, unplug immediately.
Do not fill above FULL line.

Do not cover steam outlet.

Keep control panel dry.
Do not add water directly from tap, use large bottles included in kit.

e Make sure the “click” sound is heard when closing the lid.
e Do not wash unit under running water.

e Remove lid when emptying.
e Pour out water away from the control panel (keep control panel dry).

CoMOre SeiENeE ¥XiTS * cmore.soest.hawaii.edu/education.htm



Adding and Heating Water:

1.

Dispensing Water:

Open the lid by pressing down with your thumb and pulling up on the
latch (see photo at right).

Use a bottle to fill the dispenser with water to the FULL line.

Close the lid firmly. Make sure you hear a “click”.

Connect the power cord to the heater and plug into a power outlet.

Temp! .
Set the temperature to 140°F by pressing on the control panel until W
the green indicator light next to 140°F is illuminated.

The unit will begin to heat water and will beep 9 times when complete.
The green indicator light will blink until the water cools to 140°F and will
stay a steady green while it is in “keep warm” mode. You can dispense
water at anytime.

Note: Heater will boil water first and then cool to 140°F, so it may be extremely hot for your first class. It is about
the same temperature as a fresh cup of coffee or tea so inform your students to be careful, as there is the
potential for burns.

Add more water when the water level nears the red “low water” indicator. After water is added, close the lid
o
firmly and press @ Check that the temperature is set to 140°F.

Red unlock indicator light

Press the button. The heater will beep and the red unlock indicator light will
come on (picture at right).

Hold beaker under the spout.

DISPENSE

Press and hold the O button to dispense water. Stop pushing DISPENSE when the desired water level is
almost reached. Note: Water will continue to be dispensed for a few seconds after you let go, so stop a little
early.

Emptying and Cleaning:

1.

Unplug the power cord from the outlet and disconnect the power cord from the heater.

Put the power cord in the kit box.

Remove the lid by pressing in and holding down the base of the release latch on the back of the heater. Open
the lid to a 45° angle and remove the lid. Some water will accumulate in the lid, shake out as much water as

possible. WARNING: Water and steam are very hot; allow water to cool or be extremely careful when emptying.

While holding the handle down, carefully pour the water out the back side of the heater, keeping the control
panel up. REMINDER: The control panel must not get wet!

Allow heater and lid to dry completely before reattaching the lid. To reattach the lid, press the release latch and
place the lid in the groove. Close the lid securely.



SALINITY METER GUIDE
Lesson 1: Water Stratification

The Oakton SALT 6 hand-held salinity meter is used to measure temperature and salinity. Please see the manufacturer’s
Instruction Manual in the back of the kit binder for detailed operational instructions and important safeguards.

\ Conductivity Probe

Display

Probe should be immersed in water
between wavy lines when taking
measurements.

- __\\The conductivity of the water is measured between

Yellow probe guard —»{ #88 these 2 steel bands.

Display:
Salinity measurement mode Temperature measurement
mode
A S L)
3 'ﬁ '-' OR ' ' " — -‘ '-l ‘:'
- .- o Uy P
Salinity value in parts per thousand Probe in air or salinity = 0 ppt Temperature in degrées Celsius

Measuring Salinity and Temperature:

1. Turn the salinity meter on by pressing the button once. The meter will cycle through a series of displays
showing internal settings. All LCD segments will light for two seconds, and then the meter will go into salinity
measurement mode. The display may read U if the probe is in the air or in fresh water with a salinity < 1 ppt.

2. Immerse the probe in the water so that both steel bands are in the water, but the water level should not go
above the yellow probe guard. Gently stir the water with the probe to get a homogeneous sample.

3. Allow some time for the reading to stabilize, and then record the value.
4. Press to switch to temperature mode.

5. Allow some time for the reading to stabilize, and then record the value.

6. RINSE the probe in fresh water.



Trouble-Shooting:

LCD Display:
' If the probe is in a freshwater sample, the salinity is 0 ppt. Ur means under measurement
' .. range.
‘-’ [ ] If the probe is in a salty water sample, make sure that both metal bands are submerged

and that there are no bubbles in the probe.

The salinity is OVER 50 ppt (over measurement range). Dilute sample with water or
record as > 50 ppt.

N -
e

0 When the LO indicator appears, the batteries need to be replaced or the battery
LC ? | connection is bad. Replace the batteries, but if the error continues, clean the battery

E-' S } contacts.
HO % @
5 } If HO is shown in the display, the 2 button was pressed and the value displayed will

o
HOL?
not change. Press Q\f—m once or turn the meter off and back on again.




SALINITY APPROXIMATION TABLE
Lesson 1: Water Stratification

50 ml 100 ml 200 ml 800 ml 1000 ml 1400 ml
1/4 tsp 31.7 16.6 9.2 2.7 1.8 1.6
1/2 tsp *x 30.4 18.1 5.1 3.8 2.9
3/4 tsp ** 44.4 26.0 7.5 5.7 4.1
1tsp *x ** 34.2 9.5 7.6 5.5
11/4 tsp *x *ox 41.4 11.6 9.3 6.8
11/2 tsp ** ok 47.8 13.6 11.1 8.1
13/4 tsp ** ** ok 15.8 12.8 9.3
2 tsp i i *x 17.9 14.6 10.8
21/4tsp ** ** ok 20.0 16.5 12.0
21/2tsp ** ** ** 22.0 18.0 13.2
23/4tsp * ** ** 24.0 19.6 14.4
1Tbsp i o ** 25.9 21.2 15.7

* This table gives the approximate salinity in parts per thousand (ppt) for a level measurement of salt
added to the indicated volume of water. The leftmost column lists the amount of salt and the top row
indicates the volume of water in milliliters (ml). For example, if % tsp of salt is added to 800 ml of
water, the salinity of the water becomes approximately 5.1 ppt.

**A salinity of 50 ppt or greater is beyond the range of the salinity meter used.



Water 1: Salinity

Rinse the Measuring Bottle and add 1400 ml of tap water (fill to the red line).

Measure 1 tsp of salt and carefully pour the salt into the Measuring Bottle.

Secure the lid and shake the bottle until the salt is completely dissolved.

Measure the temperature and salinity.

Record the temperature and salinity values in the table on the board and on your worksheet.

Rinse the probe in fresh water.

N o v ok~ w N e

Pour the water into the tank labeled Group Experiment 1.

Group Experiment 1: Testing variations in salinity

Water 2: Salinity

Rinse a 250 ml beaker, and then add 200 ml of tap water.

Add 1 tsp of salt to the water.

Stir until all the salt dissolves.

Measure the temperature and salinity.

Record the values in the table on the board and on your worksheet.
Rinse the probe with fresh water.

Add 2-3 drops of GREEN food dye and stir.

When instructed by your teacher, explain the properties of your water to the class.

L o N o U B~ W NoE

SLOWLY pour the water onto the exposed plastic area in the Group Experiment 1 tank so that the class
can observe what happens.

Group Experiment 1: Testing variations in salinity




L 0 N o U A~ W Noe

Water 3: Salinity

Rinse a 250 ml beaker, and then add 200 ml of tap water.

Add % tsp of salt to the water.

Stir until all the salt dissolves.

Measure the temperature and salinity.

Record the values in the table on the board and on your worksheet.

Rinse the probe with fresh water.

Add 2-3 drops of RED food dye and stir.

When instructed by your teacher, explain the properties of your water to the class.

SLOWLY pour the water onto the exposed plastic area in the Group Experiment 1 tank so that the class
can observe what happens.

Group Experiment 1: Testing variations in salinity

o u A W Noe

Water 4: Salinity

Rinse a 250 ml beaker, and then add 200 ml of COLD water.

Measure the temperature and salinity.

Record the values on the board.

Add 2-3 drops of BLUE food dye and stir.

When instructed by your teacher, explain the properties of your water to the class.

SLOWLY pour the water onto the exposed plastic area in the Group Experiment 1 tank so that the class
can observe what happens.

Group Experiment 1: Testing variations in salinity




Water A: Temperature

Rinse the Measuring Bottle and add 1400 ml of tap water (fill to the red line).
Measure the temperature and salinity.

Record the temperature and salinity values in the table on the board and on your worksheet.

L A

Pour the water into the tank labeled Group Experiment 2.

Group Experiment 2: Testing variations in temperature

Water B: Temperature

Fill a 100ml beaker with 100 ml of COLD water.

Measure the temperature and salinity.

Record the values in the table on the board and on your worksheet.
Add 2-3 drops of BLUE food dye and stir.

When instructed by your teacher, explain the properties of your water to the class.

o v r W N PR

SLOWLY pour the water onto the exposed plastic area in the Group Experiment 2 tank so that the class
can observe what happens.

Group Experiment 2: Testing variations in temperature




o v A W N oE

Water C: Temperature

Fill a 250 ml beaker with 200 ml of HOT water.

Measure the temperature and salinity.

Record the values in the table on the board and on your worksheet.

Add 2-3 drops of RED food dye and stir.

When instructed by your teacher, explain the properties of your water to the class.

SLOWLY pour the water onto the exposed plastic area in the Group Experiment 2 tank so that the class
can observe what happens.

Group Experiment 2: Testing variations in temperature

L N o U A~ W NoE

Water D: Temperature

Fill a 100 ml beaker with 50 ml of tap water.

Add % tsp of salt to the water.

Stir until all the salt dissolves.

Measure the temperature.

Record the values on the board. Record salinity as >50 ppt (it will be out of range for the probe).
Rinse the probe in fresh water.

Add 2-3 drops of YELLOW food dye and stir.

When instructed by your teacher, explain the properties of your water to the class.

SLOWLY pour the water onto the exposed plastic area in the Group Experiment 2 tank so that the class
can observe what happens.

Group Experiment 2: Testing variations in temperature




Name: Period: Group Members:

STUDENT WORKSHEET
Lesson 1: Water Stratification

Using the materials provided, try to recreate the colored layers shown in the demonstration tank. Before you begin,
take a minute to discuss amongst your group what you plan to do, and answer question 1. You can select one person to
record data in the table in question 2, but all group members must have that information and answer the questions on

their own worksheets.

1. What do you think you will have to do to make the bottom layer?

2. Fillin the table to document your experiment.

Color Water Properties Notes
Starting water Clear
1* Water Added
2" Water Added

3. Describe what happened when you added your first water.

4. Describe what happened when you added your second water.

5. Were you able to produce layers? Explain your answer.

6. Were you able to exactly replicate the demo?

7. What layer is on the bottom? What are the properties of that layer?

8. Explain why this layer is on the bottom.



Group Experiments
These two group experiments test how salinity and temperature vary with depth.

Group Experiment 1 — Testing variations in salinity:

Volume (ml) | Temperature (°C) | Salinity (ppt) Color Notes
Water 1

Water 2
Water 3
Water 4

Use the Surface, Middle, and Bottom lines as the y-axis coordinates when graphing the salinity and temperature data.

Salinity (ppt)

Surface L1 RTINS T S TN N N SO N L1
=
2 Middle
o
Bottom T T T [T T T T [T T T T T 1 T T 1

Group Experiment 2 — Testing variations in temperature:

Volume (ml) | Temperature (°C) | Salinity (ppt) Color Notes
Water A

Water B
Water C
Water D

Temperature (°C)

Surface 11 1 1 1 1 1 | | | | 1 1 1 1

Middle

Depth

Bottom

Where else might you find systems that are stratified like this?



TEACHER ANSWER KEY to STUDENT WORKSHEET
Lesson 1: Water Stratification

Using the materials provided, try to recreate the colored layers shown in the demonstration tank. Before you begin,
take a minute to discuss amongst your group what you plan to do, and answer question 1. Select one person to record
data in the table in question 2, but all group members must have that information and answer their own questions on
their own worksheet.

Email kits@soest.hawaii.edu to request a

) ] completed teacher answer key. Please
1. What do you think you will have to do to make the bottom layer? . .
include name, school and grade(s) taught in

your request. Mahalo!

2. Fillin the table to document your experiment.

Color Water Properties Notes
Starting water Clear
1* Water Added
2" Water Added

3. Describe what happened when you added your first water.

4. Describe what happened when you added your second water.

5. Were you able to produce layers? Explain your answer.

6. Were you able to exactly replicate the demo?

7. What layer is on the bottom? What are the properties of that layer?

8. Explain why this layer is on the bottom.



Group Experiments
Group Experiment 1 — Testing variations in salinity:

Volume (ml) Temperature (°C) Salinity (ppt) Color Notes

Water 1
Water 2
Water 3
Water 4

Use the Surface, Middle, and Bottom lines as the y-axis coordinates when graphing the salinity and temperature data.

Salinity (ppt)

Surface 1 1 1 1 I 1 1 1 1 I 1 1 1 1 1 1 1 I 1 1 1 1 I
b
o Middle
Q
o
Bottom

Group Experiment 2 — Testing variations in temperature:

Volume (ml) Temperature (°C) Salinity (ppt) Color Notes

Water A
Water B
Water C
Water D

Temperature (°C)

Surface
Email kits@soest.hawaii.edu to request a
< completed teacher answer key. Please
e  Middle b—— . .
2 include name, school and grade(s) taught in
your request. Mahalo!
Bottom

Where else might you find systems that are stratified like this?



POWERPOINT SCRIPT
Lesson 1: Water Stratification

Slide 1:

During the experiment with water stratification, you discovered that water with different temperatures and salinities
stratifies and forms layers. Stratification occurs because of differences in water density: less dense water floats on
denser water. You may not have realized it, but you also made a model of the ocean. Most areas of the ocean are
layered just as the water in the tank. The ocean is so large that we cannot bring it into the classroom nor can we easily
go out and observe its layers. Models such as the one you created help us understand the ocean’s properties by
representing these properties in a simple way. (click)

Slide 2:

Now the different layers of water are going to be represented by colored rectangles. A red box (click) will represent the
top layer, white represents the middle, and blue the bottom. In the experiment varying the water temperature, you
graphed the layered water system (click) by having the vertical y-axis represent depth with the surface of the water at
the top of the graph and getting deeper as you go down. The horizontal x-axis represented (click) temperature with
colder temperatures at the left and warmer temperatures at the right. Moving the colored layers to the side (click),
plotting the points of the temperature experiment may have resulted in a graph that looked like this, where the
warmest water was in the top layer, the mid-temperature water was in the middle, and the cold water was at the
bottom. Looking at the graph, one interpretation would be that water gets colder as you go deeper. You may have
experienced this while swimming. (click)

Slide 3:

We have used colored boxes to represent the layers of colored water in the tank. Now these colored boxes are going to
represent the layers in the ocean, but let’s change (click) the size of the boxes to more accurately represent the
proportion of the layers as they exist in the ocean. (click)

Slide 4:

While looking out at the surface of the ocean, it is easy to think that the water is the same all the way to the bottom
(click). But there are actually two separate layers with specific properties: a relatively warm, shallow surface layer and a
cold, deep layer. The layers are separated by a transition zone (click) where there are distinct changes in temperature,
salinity, and density. This zone (click) acts as a barrier between the surface and deep ocean and shares some properties
of both layers (click). How do the layers form? (click)

Slide 5:

Without the heat from the sun, the ocean would be the same temperature throughout. The layers (click) form because
the surface is heated by the sun. This water (click) is mixed by the wind and waves to form the warmer surface layer.
The transition zone (click) forms below the surface layer and is where the temperature changes from the warm, surface
layer above to the cold deep water below. Because the surface water is warmer, it is less dense and floats on the colder
water below. How do we know the ocean is layered like this? (click)

Slide 6:

...by taking the temperature of the ocean. Oceanographers go out on research ships and lower an instrument (click)
called a CTD into the ocean. CTD stands (click) for the variables that it measures: Conductivity, Temperature, and Depth.
Conductivity is the measure of how much electrical current seawater can carry, which is directly related to the saltiness
or salinity. Therefore, conductivity measurements can be converted to salinity. (click)



Slide 7:

This is a graph of ocean temperatures from a CTD. Depth is shown on the vertical y-axis. The ocean surface is (click)
represented as 0 m at the top, and depth increases as you move down. The graph extends down to a depth of 4500 m,
and even though this is almost three miles underwater, the bottom of the ocean can be even deeper. The horizontal x-
axis represents temperature; (click) cold water is on the left and temperature increases as you go to the right. The curvy
red line (click) shows how temperature changes with depth. Notice that from the surface to about 200 m (click) the red
line is vertical indicating that ocean temperature is the same over this depth range. The water in this surface layer has
been mixed by winds and waves and is all the same temperature. From 200 m to 1000 m (click), notice how the
temperature changes markedly with depth, indicated by the shallow angle of the red line from about 22°C to 5°C. The
thermocline (click) is the portion of the water column where the water temperature changes rapidly with depth; thermo
means heat and cline means slope or bend. The thermocline acts as a barrier between the well-mixed surface layer and
the deep ocean. The deep ocean (click) is the water that is found below the thermocline. It is a region that is cold and
dark with an average temperature of 4°C. Ninety percent of the volume of the world’s ocean is this cold, deep water,
even in the tropics (click). So why do the layers form? And why is most of the ocean 4°C? (click)

Slide 8:

...because of differences in water density. Density is mass per unit volume. Dense material, like metal, has much more
mass for the same volume when compared to something less dense, like Styrofoam. Water (click) can also have
different densities, which causes less dense water to float on denser water. Water is densest at 4°C, which is why most
of the deep ocean is this temperature. (click)

Slide 9:

This graph of water density shows that, as with temperature, there is an area where the density changes markedly with
depth (click). This area is known as the pycnocline; pycno means thick or dense and cline means slope or change. For
most areas of the ocean (click), temperature has a greater effect on density than salinity. Unless there is a large influx of
freshwater from a river or precipitation, differences in ocean temperature are much greater than differences in salinity.
(click)

Slide 10:

Separating the surface layer and the deep water is the transition zone, which is made up of the thermocline and
pycnocline. This region of temperature and density changes acts like a (click) boundary between the surface and deep
ocean. Water will move horizontally relatively easily in the layers (click), but does not move vertically across the
boundary (click). With some regional exceptions (click), most of the ocean is stratified like this. (click)

Slide 11:

The properties of the surface layer are directly affected by the sun (click), which warms the water and provides light for
photosynthesis (click). The surface layer is also influenced by wind and waves (click), which mix the water. Deep water
is not directly influenced by the sun, as most of the sun’s energy is absorbed in the surface layer. Instead, (click) the
deep ocean is cold and dark without enough light for photosynthesis. Like plants on land, marine plants also need
nutrients. Therefore, there are few (click) nutrients in the surface ocean because they are used up by the marine plants
that live there. When marine organisms create waste or die, microbes break down this material and return nutrients to
the ocean. Often (click) the decomposing matter sinks below the boundary before it is completely broken down. As
more decaying matter sinks below the boundary, (click) nutrients accumulate in the deep ocean when organisms there
break down the decomposing matter (click).

Slide 12:

In summary, most of the ocean is stratified due to density differences, which are controlled by temperature and salinity.
The surface ocean (click) is relatively warm and is lit by the sun (which allows photosynthesis to occur), but it has less
nutrients. The deep ocean (click) is cold and dark, so no photosynthesis occurs there, but it has more nutrients. The
different properties affect where fish and other organisms live and even how the oceans move. (END)



TEACHER GUIDE
Lesson 2: Deep Ocean Circulation

Time Required: 70 minutes. Advance preparation time will vary from 20 minutes to more than 1 hour, depending on
which background materials are reviewed.

Structure: This lesson enables students to apply the concepts that they learned during the density experiment in Lesson
1: Water Stratification to the global ocean. Students watch a narrated PowerPoint presentation about the water
properties and processes that drive ocean circulation. By making a Mobius strip model and filling out a map and
worksheet, they reinforce their understanding of the ocean conveyor belt. An additional reading and accompanying
worksheet may be assigned as homework to introduce students to the effects of climate change on ocean circulation.
Finally, students will complete the OCEAN CONVEYOR BELT SURVEY- Lessons 1 and 2 as a post-survey (5 minutes); the
pre-survey was given at the beginning of Lesson 1.

Materials: (Paper materials contained in binder are shown in BOLD CAPS)
Materials are provided for students to work in 7 groups of 4 students per group.
1. POWERPOINT SCRIPT — Lesson 2: Deep Ocean Circulation

2. STUDENT WORKSHEET - Lesson 2: Mapping Deep Ocean Circulation

3. MOBIUS STRIP (Part A) — Lesson 2: Mapping Deep Ocean Circulation

4. MOBIUS STRIP (Part B) — Lesson 2: Mapping Deep Ocean Circulation

5. BLANK WORLD MAP

6. TEACHER ANSWER KEY to STUDENT WORKSHEET — Lesson 2: Mapping Deep Ocean Circulation
7. TEACHER ANSWER SHEET — Deep Ocean Circulation Map

8. NATIONAL GEOGRAPHIC NEWS article

9. STUDENT WORKSHEET — Lesson 2: Ocean Circulation Article

10. TEACHER ANSWER KEY to STUDENT WORKSHEET - Lesson 2: Ocean Circulation Article

11. OCEAN CONVEYOR BELT SURVEY - Lessons 1 and 2

12. TEACHER ANSWER KEY to OCEAN CONVEYOR BELT SURVEY — Lessons 1 and 2 } Provided in Lesson 1
13. CD with narrated PowerPoint presentation

14. Laminated Mobius strip teacher answer key

15. Colored pencils (14 each of red, blue, and purple)

16. Scissors (7)

17. Transparencies of Surface Ocean Currents (7)

18. Speakers

Materials Not Included in this Kit but Needed for Lesson 2:
19. Transparent tape
20. Computer with PowerPoint software and CD drive
21. Projector

Advance Preparation:
1. Ashort, narrated PowerPoint presentation entitled Lesson 2_Deep Ocean Circulation_NARRATED is located on
the CD. This presentation will be used to introduce your students to ocean circulation. Load the PowerPoint
onto your computer by dragging the folder labeled Lesson 2 from the CD onto your computer desktop.

2. Speakers are included in the kit for playing the narrated presentation. Refer to the laminated manual attached
to the speaker storage case for set-up instructions.

3. If you prefer to present the information yourself, load the non-narrated version of the PowerPoint presentation.
POWERPOINT SCRIPT — Lesson 2: Deep Ocean Circulation is included as a guide.

4. Once the presentation has been loaded, eject the CD and return it to the binder.



5. Make double-sided copies of MOBIUS STRIP (Part A) — Lesson 2: Mapping Deep Ocean Circulation and MOBIUS
STRIP (Part B) — Lesson 2: Mapping Deep Ocean Circulation. One double-sided copy of Part A and one double-
sided copy of Part B will make four Mdbius strips. Make as many double-sided copies as you need in order that
each student can make a Mobius strip. Double check that the two sides of each strip are different, so that one
side describes changes in oxygen and the other describes currents. The text on one side of each page will be
upside down relative to the other side, in order to provide continuity of the text on a finished strip. A completed
Mobius strip is included as an example.

6. Photocopy or print the STUDENT WORKSHEET — Lesson 2: Mapping Deep Ocean Circulation, the BLANK WORLD
MAP, and if you have not already distributed it, the GLOSSARY (one of each per student).

7. Photocopy or print OCEAN CONVEYOR BELT SURVEY - Lessons 1 and 2 (one per student). This was given as a
pre-survey before Lesson 1 and is given as a post-survey at the end of this lesson. If you are omitting Lesson 1,
have students complete the survey at both the beginning and end of this lesson (you will need to print two
copies per student).

8. Students should work in groups of four. Materials are provided for up to seven groups. Place a set of the
following supplies at each of 7 stations around the classroom:
a. 1 pair of scissors
2 sets of colored pencils (red, blue, and purple)
1 double-sided copy of MOBIUS STRIP (Part A) — Lesson 2: Mapping Deep Ocean Circulation
1 double-sided copy of MOBIUS STRIP (Part B) — Lesson 2: Mapping Deep Ocean Circulation
Transparent tape (8 small pieces)
Transparency of World Map with Surface Ocean Currents

A

9. Optional homework assignment: Photocopy or print the NATIONAL GEOGRAPHIC NEWS article and STUDENT
WORKSHEET - Lesson 2: Ocean Circulation (one of each per student).

Instructional Procedures:
1. Play the narrated PowerPoint presentation entitled Lesson 2_Deep Ocean Circulation NARRATED to familiarize

your students with the forces that drive ocean circulation.
2. Organize students into groups of four and direct them to the stations that you set up around the classroom.

3. Distribute a copy of STUDENT WORKSHEET - Lesson 2: Mapping Deep Ocean Circulation and a BLANK WORLD
MAP to each student.

4. Instruct students to follow and complete STUDENT WORKSHEET — Lesson 2: Mapping Deep Ocean Circulation.

5. Optional: Distribute a copy of the NATIONAL GEOGRAPHIC NEWS article and STUDENT WORKSHEET — Lesson 2:
Ocean Circulation Article to each student. Assign your students to read the article and answer questions on the
corresponding worksheet for homework.

Assessment and Clean-up:
1. Pass out OCEAN CONVEYOR BELT SURVEY - Lessons 1 and 2 (one per student). Have students check the post-
survey box and answer the questions (allow 5—-10 minutes). A TEACHER ANSWER KEY is provided for your

convenience.

2. If you are not completing additional lessons:
e Asthe students are completing their surveys, we would be grateful if you would complete the TEACHER
EVALUATION of this kit. All comments, corrections, and suggestions are very welcome. If you prefer,
you can complete the evaluation online (see TEACHER EVALUATION for website address).



Re-pack the kit for return to C-MORE. Double check that all the items are included and in their proper
place by completing the SUPPLY CHECKLIST. Please make a note of missing, broken, or damaged items
so that they can be replaced. Please pack the kit so that the materials are stored as they were when you

received them. Please also include a copy of the students' pre- and post- surveys.

Mahalo!



~70 minutes: After viewing a PowerPoint presentation, students work in groups to complete individual Mobius strip
models and maps of ocean circulation.

10 minutes: The narrated PowerPoint presentation, entitled Lesson 2_Deep Ocean Circulation, introduces basic
ocean circulation.

~45 minutes: Students work together in groups.

Part 1: Maobius Strip (~15 minutes)

e Students color and connect the ends of a Mdbius strip to illustrate how temperature and oxygen change
along the ocean conveyor belt.

Part 2: Mapping Deep Ocean Circulation (~20 minutes)

e Students label geographical features and deep sea oxygen concentrations on a blank map to help them
trace the pathway of deep ocean circulation.

Part 3: Worksheet (~10 minutes)
e Students use their Mo6bius strip and map to answer questions about ocean circulation.

5-10 minutes: Each student completes and turns in the OCEAN CONVEYOR BELT SURVEY — Lessons 1 and 2 (post-
test).

3-5 minutes: Optional: Assign students to read the NATIONAL GEOGRAPHIC NEWS article and answer the questions
on the STUDENT WORKSHEET — Lesson 2: Ocean Circulation Article as homework.




POWERPOINT SCRIPT
Lesson 2: Deep Ocean Circulation

Slide 1:
Though the ocean may sometimes appear to be still, it is always moving, even at great depths. In fact, the ocean moves
around the entire world in a circulation pattern called the ocean conveyor belt. (click)

Slide 2:

Ocean currents are ultimately powered by energy from the sun, but how the oceans are affected by the sun depends on
latitude. The intensity of sunlight is highest in the tropics and decreases as you go towards the poles. Here, the yellow
bars represent the same amount of sunlight hitting the earth at different parts of the globe. At 60° north (click), the
approximate latitude of Anchorage, Alaska, the same amount of sunlight would only have about half the intensity of
sunlight as that at the equator. To think about it another way (click), if you took the sun that was hitting a square this
big at the equator, it would be spread out over a square this big at 60° north. Because of differences in sunlight
intensity, the average annual temperature in the Galapagos Islands on the equator is about 76°F while it is only 36°F in
Anchorage, Alaska. This difference in sunlight intensity causes the oceans to heat differently. (click)

Slide 3:

This image shows temperatures of the ocean surface across the world. Temperature is color-coded where red colors
indicate warmer temperatures, and blue and violet indicate colder temperatures. For example, the reddish area in the
middle of the map shows that the oceans are warmer in the tropics. The heat absorbed in the tropics is transported
north and south to higher latitudes by atmospheric and oceanic circulation. (click)

Slide 4:

Seawater that is heated (click) in the tropics is transported to higher latitudes by surface currents that are created by
global wind patterns. In the Atlantic (click), the Gulf Stream transports warm tropical water north, which keeps Western
Europe relatively mild and even allows palm trees to grow in Ireland (click). While surface currents are extremely
important in the oceans, they occur in the surface layer and are only a part of global ocean circulation. (click)

Slide 5:

In contrast to wind-driven surface currents, deep ocean circulation is driven by changes in density. There are only a few
places on earth where the environmental conditions change the density of seawater in a way that results in the
formation of deep water. Deep water formation simply refers to the process whereby seawater sinks from the surface
to the deep ocean. (click)

Slide 6:

Surface water cools as it flows towards the polar regions (click). Salt doesn’t freeze, therefore when seawater is exposed
to freezing temperatures, only the fresh water freezes (click). The ice crystals expel the salt into the surrounding
seawater, which increases the salinity of the water. As water gets saltier and colder (click), it gets denser, which causes
the water to sink. This sinking, cold, salty water marks the beginning of a global circulation pattern called the ocean
conveyor belt. (click)

Slide 7:

Click on the image to play the video. Click on the image again to pause or replay the video. Click on the slide background
to continue to the next slide.

During the stratification experiment, you saw examples of colder, saltier water sinking and flowing under another type
of water. Not only were you modeling layering in the ocean, you were also modeling deep ocean currents. You may
have even seen the currents hit a boundary, such as the side of the box, and flow upwards. This model shows newly
formed deep water flowing under existing water when the blue water is poured in at the right, and upwelling when the
water hits a land mass, or in our case, the side of the container. This is the essence of the ocean conveyor belt. Now
let’s see where these processes occur in the ocean. (click)



Slide 8:

In the North Atlantic (click), surface water cools, becomes denser, sinks (click) and flows as a deep, cold current around
the globe. In the Pacific, the water becomes less dense and rises to the surface (click). The water sinking in the North
Atlantic is replaced by a shallow current of relatively warm water. While in reality the surface water flows (click)
through complex surface currents, the general motion is simplified as a shallow, warm current. Together, the cold, deep
current and the warm, surface current combine to circulate seawater around the earth. This is the ocean conveyor belt.
(click)

Slide 9:

Click on the map to play the video. After playing the video, click to continue to the next slide.

“The global conveyor belt is the major system that carries heat in Earth’s ocean. The heat transport of this system helps
to moderate Earth’s climate. This model shows, in a simple way, how heat is transported from the lower and mid-
latitudes to the far North Atlantic. Shallow currents are warm and shown as red. Deep, cold currents are colored blue.
The moving pulse shows the general direction in which ocean currents flow. Cold, deep currents travel east pass Africa.
Some part of the flow rises in the Indian Ocean. The rest of the cold current continues flowing toward the North Pacific
Ocean. In the Pacific, the current becomes warmer and less salty and migrates as a surface current towards the North
Atlantic. In the North Atlantic, dry winter air cools the ocean surface. This removes heat from ocean waters and makes
them salty and dense. When this water sinks to great depth, the global conveyor belt again begins its worldwide circuit.
The entire process takes as long as one thousand years to complete.”

Slide 10:

The ocean conveyor belt is also called thermohaline circulation. Thermo means heat and haline refers to salt.
Thermohaline circulation is caused by changes in temperature and salinity. Since changes in temperature and salinity
change the density of water, thermohaline circulation is driven by density differences. (click)

Slide 11:
Why is thermohaline circulation important? (click) The ocean conveyor belt regulates climate by transferring heat,
affects the cycling of nutrients, and transports oxygenated water to the deep ocean. (click)

Slide 12:

There are less nutrients in the surface ocean because they are used by photosynthetic marine plants called
phytoplankton (click). During photosynthesis, phytoplankton produce and release oxygen into the surface ocean.
Additionally (click), oxygen is mixed into the ocean from the atmosphere at the surface, and consumed by organisms
breathing. Because oxygen is both produced and consumed, oxygen levels in the surface ocean vary geographically. In
the deep ocean, there is no photosynthesis or contact with the atmosphere. The only way oxygen gets into the deep
ocean (click) is when surface water at the poles cools and sinks, bringing oxygen with it to the deep ocean. In the deep
ocean, oxygen is only consumed and not produced; therefore, oxygen levels can only decrease as water moves through
the deep ocean. (click)

Slide 13:

Scientists agree that global climate change is occurring. How will climatic differences affect the ocean conveyor belt?
(click) Sea ice and glaciers are already melting, and precipitation is predicted to increase in the Arctic. The combination
of increased precipitation and melting ice (click) will decrease the salinity in the ocean where deep water is formed.
Such changes in ocean density could stop the formation of the cold, salty, deep water that powers the ocean conveyor
belt. A change in the ocean conveyor belt would affect the climate by changing the way heat is transferred on Earth.
(END)



Name: Period:

STUDENT WORKSHEET
Lesson 2: Mapping Deep Ocean Circulation

Part 1: Md&bius strip

1. Have one person in your group use the scissors to cut along the grey dashed lines on the sheets labeled MOBIUS
STRIP (Part A) — Lesson 2: Mapping Deep Ocean Circulation and MOBIUS STRIP (Part B) — Lesson 2: Mapping
Deep Ocean Circulation.

2. Take one strip of paper representing surface water and one strip of paper representing deep water and
upwelling water. Color both sides of your strips using the following key: surface water = RED, deep water =
BLUE, and upwelling water = PURPLE.

3. Once you have colored your strips of paper, make a single long strip of paper by placing the two ends of the
strips of paper that have Pacific Ocean printed on them next to another. Tape these two strips of paper
together.

4. Once you have your single long strip of paper, make a single half-twist and tape the ends of the paper that have
North Atlantic printed on them together to form a loop. Starting at the North Atlantic, read though your Mébius
strip model of ocean circulation and use the model to help answer some of the questions in this worksheet.

Part 2: Mapping deep ocean circulation N

1. Write your name and draw a compass rose, i.e., w ; < £, in the upper right hand corner of the map.

2. Label the continents:

a. Africa

b. Antarctica

c. Asia

d. Australia

e. Europe

f.  North America
g. South America

3. Label the oceans:
Atlantic Ocean
Arctic Ocean
Indian Ocean
Pacific Ocean
Southern Ocean

T oo oo

4. Mark the general location of your school with a star.
5. With a pencil, shade the region of deep water formation.
6. Oxygen concentrations were measured at 4000m depth at six locations around the world. Next to each asterisk

(*), record on your map the deep sea oxygen concentration for each site listed below:
Sampling | Oxygen concentration Sampling Oxygen concentration

site (mlI/1) site (ml/1)
NA1l 5.9 SAl 5.0
NA2 6.7 SP1 4.0

NP1 3.4 S1 4.9




7. As deep water flows, oxygen decreases because it is used up in respiration and decomposition. Based on this
information, indicate the pathway of deep water in the global ocean conveyor belt by using a blue colored pencil
to draw arrows between the sampling sites on your map.

8. Remember that the arrows you drew on your map only illustrate deep ocean circulation. To model the world
ocean circulation, hold the deep water portion of a Mobius strip flat along the map of deep water currents map
so that the oceans on the strip align with the oceans on the map (the strip will cover land). Hold the
transparency of surface currents over your map and Mobius strip so that the transparency of surface currents is
aligned with the surface portion of the Mdbius strip and the two maps line up.

9. Compare surface and deep ocean circulation. Surface ocean currents are more complex than deep ocean
currents because surface currents are driven by whereas deep ocean currents are driven
by

10. Add a descriptive title to the bottom of your map.

Part 3: Understanding ocean circulation

1. Oxygen content is generally higher in the deep ocean than the surface ocean. Circle one: True False

2. The youngest deep water is found in the Ocean.

3. Deep ocean oxygen concentrations in the Pacific are lower than those in the Atlantic because of
a. respiration

b. age
c. decomposition
d. all of the above
e. none of the above
4. Oxygen is supplied to the ocean through and gas exchange with the atmosphere.

5. Deep water formation is caused in part by

a. high salinity, moderate density, and high temperature
high salinity, high density, and ice formation

low salinity, ice formation, and low temperature

low glacial melt and high precipitation

none of the above

©oo o

6. Water flows from the surface of the Atlantic Ocean to the surface of the Pacific Ocean. Circle one:
True False

7. Which of the following is NOT required for photosynthesis?

a. Light

b. Water

c. Oxygen

d. Nutrients

e. Carbon dioxide

f. None of the above

8. Will the Atlantic Ocean be drained at the end of 1000 years? Explain why or why not.
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TEACHER ANSWER KEY to STUDENT WORKSHEET
Lesson 2: Mapping Deep Ocean Circulation

Part 1: Mobius strip Email kits@soest.hawaii.edu to request a
completed teacher answer key. Please
include name, school and grade(s) taught in
your request. Mahalo!

Part 2: Mapping deep ocean circulation

For question 8, students should hold the Mdbius strip between the map of deep ocean currents they created
and a transparency of surface ocean currents, as shown in Figure 1.

Figure 1. Top view (left) and side view (right) of Mobius strip between the BLANK WORLD MAP students will
have completed and the transparency of Surface Ocean Currents.

9. Compare surface and deep ocean circulation. Surface ocean currents are more complex than deep ocean
currents because surface currents are driven by whereas deep ocean currents are driven by

Part 3: Understanding ocean circulation

1. Oxygen content is generally higher in the deep ocean than the surface ocean. Circle one: True False

2. The youngest deep water is found in the Ocean.

3. Deep ocean oxygen concentrations in the Pacific are lower than those in the Atlantic because of

a. respiration
b. age
c. decomposition
d. all of the above
e. none of the above
4. Oxygen is supplied to the ocean through and gas exchange with the atmosphere.

CeMOreée SerENeE cmore.soest.hawail.edu/education.htm



Deep water formation is caused in part by .
a. high salinity, moderate density, and high temperature
high salinity, high density, and ice formation
low salinity, ice formation, and low temperature
low glacial melt and high precipitation
none of the above

®oo o

Water flows from the surface of the Atlantic Ocean to the surface of the Pacific Ocean. Circle one:
True False

Which of the following is NOT required for photosynthesis:

a. Light

b. Water

c. Oxygen

d. Nutrients

e. Carbon dioxide

f. None of the above

Will the Atlantic Ocean be drained at the end of 1000 years? Explain why or why not.

Email kits@soest.hawaii.edu to request a

completed teacher answer key. Please
include name, school and grade(s) taught in
your request. Mahalo!



NATIONAL GEOGRAPHIC NEWS

NATIONALGEOGRAPHIC.COM/NEWS

Global Warming May Alter Atlantic Currents, Study Says

John Roach for National Geographic News
Article accessed online 10 January 2010

In the 2004 eco-disaster film The Day After Tomorrow, Europe and North America are gripped by a
deep freeze after global warming halts the circulation of a North Atlantic ocean current. The film is
pure Hollywood hyperbole.

But some scientists say the current is vulnerable to rising temperatures.

Acting like a conveyor belt, the current transports warm, surface waters toward the Poles and cold,
deep waters toward the Equator.

In the Atlantic Ocean, these warm surface waters push northward, releasing heat into the atmosphere
and becoming cooler and denser. As they do, the waters sink and flow southward in the deep ocean.

"The Atlantic circulation moves heat toward the Arctic, and this helps moderate wintertime
temperatures in the high-latitude Northern Hemisphere," said Ruth Curry, a physical oceanography
research specialist at the Woods Hole Oceanographic Institution on Cape Cod, Massachusetts.

Curry noted that excessive amounts of freshwater dumped into the North Atlantic could alter seawater
density and, in time, affect the flow of the North Atlantic ocean current. (Global warming has boosted
freshwater runoff in the form of glacier meltwater and additional precipitation, Curry said.)

Just how much extra freshwater it would take to alter the circulation system, known as the Atlantic
Meridional Overturning Circulation, is a gray area of climate science.

Broken Belt?

Suffice it to say that the conveyor belt continues to work today. But freshwater runoff into the North
Atlantic has increased in recent decades, and runoff is expected to increase further as global
temperatures climb higher, Curry said.

Curry and research colleague Cecilie Mauritzen of the Norwegian Meteorological Institute in Oslo
estimate that it will take about a century, at present rates, for the circulation pattern to be seriously
affected by the increase in freshwater runoff.

The scientists conclude that it would take about two centuries for freshwater runoff to halt the North
Atlantic conveyor belt entirely. Curry and Mauritzen published their findings in the June 17 issue of
the research journal Science.

Stefan Rahmstorf, a professor of ocean physics at Potsdam University in Germany, said the
researchers' calculations appear accurate.

But he emphasized that their findings do not provide a forecast; they only give an impression of the
amount of freshwater required to alter or halt the North Atlantic ocean current.



"It is of course very unlikely that the freshening [freshwater inflow] will simply continue at the same
rate it has for the past few decades," he wrote in an e-mail to National Geographic News.

Rahmstorf said the freshening could be part of a natural fluctuation in Earth's climate system that will
stop and reverse.

He added, however, that if the phenomenon is due to global warming, which he said is likely, then the
freshening will probably accelerate as glaciers melt and more rain falls at high latitudes in response to
rising temperatures.

Unpredictable Climate

According to Curry, scientists are uncertain as to the exact course global warming will take and how it
will affect the amount of freshwater flowing in the North Atlantic. A particular wild card, she noted, is
Greenland.

"As it does melt, it will release freshwater into the Nordic seas"—water bodies found between Iceland,
Greenland, and Norway—"and that probably represents the biggest source of freshwater that could
have an impact on the conveyor belt," she said.

There are a number of mechanisms that could inject large amounts of freshwater into the Nordic seas
at the precise region that is critical to the conveyor belt. They include

* pooling and release of glacial meltwater,
* collapse of an ice shelf followed by a surge in glacier movement, or
* [decreased friction along] a glacier's base through increased melting [basal sliding].

According to an unpublished survey by Potsdam University researchers Kirsten Zickfeld and Anders
Levermann, expert scientific opinion varies widely on the likelihood that excess freshwater runoff from
the Arctic will alter the North Atlantic conveyor belt in this century.

Some scientists consulted for the survey said there is no chance that the current will break down.
Others estimated that the chance of a complete shutdown exceeds 50 percent if global warming
climbs by 7.2° to 9° Fahrenheit (4° to 5° Celsius) by 2100.

Rahmstorf believes the chance of a circulation shutdown is as high as 30 percent. He said any
possibility of such a scenario, even if slight, is cause for concern.

"Nobody would accept expanding nuclear power if there was a 5 percent risk of a major accident,” he
said. "Why would we accept expanding oil and coal power if there is a 5 percent risk of a major
climate accident?"

© 1996-2008 National Geographic Society. All rights reserved.
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STUDENT WORKSHEET
Lesson 2: Ocean Circulation Article

Read the NATIONAL GEOGRAPHIC NEWS article titled Global Warming May Alter Atlantic Currents, Study Says and
answer the questions below using complete sentences.

1. How iscirculation in the Atlantic Ocean related to Europe’s climate?

2. What happens to Atlantic Ocean water when it reaches the Arctic? Why does this happen?

3. What do scientists suggest may affect ocean circulation in the North Atlantic?

4. Infer from the article what water properties scientists most commonly measure to study ocean circulation.
Name at least two properties and explain why they are measured.

5. Name four processes that may accelerate the addition of freshwater to the Atlantic Ocean at high latitudes?

6. The article ends with a comment from Dr. Stefan Rahmstorf. To what climate accident is he referring and how is
this type of accident related to expanding oil and coal power?



TEACHER ANSWER KEY to STUDENT WORKSHEET
Lesson 2: Ocean Circulation Article

Read the NATIONAL GEOGRAPHIC NEWS article titled Global Warming May Alter Atlantic Currents, Study Says and
answer the questions below using complete sentences.

1. How iscirculation in the Atlantic Ocean related to Europe’s climate?

Email kits@soest.hawaii.edu to request a

completed teacher answer key. Please
include name, school and grade(s) taught in
your request. Mahalo!

2. What happens to Atlantic Ocean water when it reaches the Arctic? Why does this happen?

3. What do scientists suggest may affect ocean circulation in the North Atlantic?

4. Infer from the article what water properties scientists most commonly measure to study ocean circulation.
Name at least two properties and explain why they are measured.

5. Name four processes that may accelerate the addition of freshwater to the Atlantic Ocean at high latitudes?

6. The article ends with a comment from Dr. Stefan Rahmstorf. To what climate accident is he referring and how is
this type of accident related to expanding oil and coal power?



TEACHER GUIDE
Lesson 3: Using Data to Explore Ocean Processes

Time Required: 70 minutes. Advance preparation requires an additional 30—60 minutes.

Structure: This Internet-based lesson provides an overview of oceanographic research and introduces students to
oceanographic time-series data. First, students watch a short PowerPoint presentation and complete a worksheet
related to the PowerPoint (20 minutes). Students then access time-series data from a website, and graph, analyze, and
interpret these data (50 minutes). A pre- and post- survey is NOT included for this lesson.

Materials: (Paper materials contained in binder are shown in BOLD CAPS)

1.
2.
3.

~

POWERPOINT SCRIPT - Lesson 3: Using Data to Explore Ocean Processes

STUDENT WORKSHEET — POWERPOINT - Lesson 3: Using Data to Explore Ocean Processes

TEACHER ANSWER KEY to STUDENT WORKSHEET — POWERPOINT - Lesson 3: Using Data to Explore Ocean
Processes

STUDENT WORKSHEET — HOT-DOGS - Lesson 3: Using Data to Explore Ocean Processes

TEACHER ANSWER KEY to STUDENT WORKSHEET — HOT-DOGS - Lesson 3: Using Data to Explore Ocean
Processes

GLOSSARY

CD with narrated PowerPoint presentations

Speakers

Materials Not Included in this Kit but Needed for Lesson 3:

9.

Computers with high-speed Internet access (e.g., cable modem, DSL, broadband)

10. Projector

Advance Preparation:

1.

Photocopy or print the STUDENT WORKSHEET — POWERPOINT and the STUDENT WORKSHEET — HOT-DOGS
(one of each per student). TEACHER ANSWER KEYS to both worksheets are provided for your convenience.

You may have already distributed the GLOSSARY to students during a previous lesson. If not, photocopy or print
the GLOSSARY (one per student).

A short narrated PowerPoint entitled Lesson 3_Using Data to Explore Ocean Processes NARRATED can be found
on the CD. Load this file onto your computer by dragging it from the CD onto the desktop.

Speakers are included in the kit for playing the narrated presentation. Refer to the laminated manual attached
to the speaker storage case for set-up instructions.

If you prefer to present the information yourself, load the non-narrated version, Lesson 3_Using Data to Explore
Ocean Processes_NON-NARRATED. POWERPOINT SCRIPT - Lesson 3: Using Data to Explore Ocean Processes is
included as a guide.

Once the presentation has been loaded, eject the CD and return it to the binder.

Obtain access to computers that have high-speed Internet access. We recommend two students per computer.

Familiarize yourself with the online Hawai‘i Ocean Time-series Data Organization and Graphical System or HOT-
DOGS (http://hahana.soest.hawaii.edu/hot/hot-dogs/).

If you have time, explore the virtual HOT cruise website and show some videos to your students during class to
give them a sense of life and research at sea (http://www.soest.hawaii.edu/HOT WOCE/vcruise/vc.html).




Videos are viewable using a Windows Media Player or Quicktime or Real Video players. If one of these programs
is not installed, the website will direct you to an Internet link where you can download one.

Instructional Procedures:

1.

Distribute one copy of the GLOSSARY and one copy of the STUDENT WORKSHEET — POWERPOINT to each
student. Students will complete this worksheet during and after the PowerPoint presentation.

Play the narrated PowerPoint presentation Lesson 3_Using Data to Explore Ocean Processes NARRATED to
provide your students with some background on oceanographic research and to familiarize them with
oceanographic time-series and monitoring sites (7 minutes).

After the PowerPoint ends, give your students an additional ~5 minutes to complete the STUDENT WORKSHEET
— POWERPOINT.

As a class, take ~5 minutes to go over the answers to the STUDENT WORKSHEET — POWERPOINT and discuss
any questions or comments about the concepts.

If desired, visit the Virtual Hot Cruise website: http://www.soest.hawaii.edu/HOT WOCE/vcruise/vc.html and
show your students some images or video. We recommend the Introduction to HOT Cruises video.

Distribute a copy of the STUDENT WORKSHEET — HOT-DOGS to each student.

Depending on the number of computers available, have the students work individually or in pairs and assign
them to computer stations. We recommend two students per computer.

Students should be able to complete STUDENT WORKSHEET — HOT-DOGS without much assistance.

Lesson 3: Overview

70 minutes: After viewing the PowerPoint presentation and completing a review worksheet, students work on an
Internet-based lesson using time-series data.

PowerPoint Presentation & Accompanying Worksheet (20 minutes)

e Narrated PowerPoint presentation introduces at-sea data collection and long-term oceanographic
studies.

e During and after the PowerPoint, students complete a short worksheet.

e Teacher leads a class review of the worksheet to address any questions or misconceptions.

e |f desired, teacher can take students on a virtual HOT cruise.

Internet-Based lesson & Accompanying Worksheet (50 minutes)

e Students access data from an oceanographic time-series database to explore biological and chemical
cycles in the ocean. Students graph, analyze, and interpret these data, following step-by-step
instructions on the accompanying worksheet.




POWERPOINT SCRIPT
Lesson 3: Using Data to Explore Ocean Processes
Slide 1:
The ocean is a very dynamic environment due to differences in water density and heat exchange with the atmosphere.
Processes such as wind, ice formation, and evaporation drive ocean currents that circulate seawater around the globe,
effectively connecting seemingly separate oceans into one, single ocean.

However, properties such as temperature, salinity, and nutrients change with time and location. By studying these
properties, scientists aim to better understand how the ocean functions. But how exactly do scientists study an
environment that is as vast and difficult to access as the ocean? Let’s find out more about how to use data to explore
ocean processes. (click)

Slide 2:

One of the most important oceanographic sampling devices is a CTD package. A CTD is an electronic instrument named
for the three variables (click) that it measures: conductivity, temperature, and depth. We measure conductivity to
determine the salinity of the ocean because the ions in salt improve the ocean’s ability to conduct electricity. Similarly,
the depth of the CTD is determined by a pressure sensor because pressure is directly proportional to depth and can be
measured very accurately. A CTD package (click) is a CTD surrounded by sampling bottles called Niskin bottles. (click)

Slide 3:

Scientists take research ships out to sea and deploy CTD packages. By lowering the CTD to different depths (click),
scientists can electronically measure how variables such as temperature and salinity vary from the surface to the deep
ocean. The bottles that surround the CTD are used to collect water samples from specific depths. When the CTD
package is lifted back on deck, the water samples can be tested in the lab for nutrients and other compounds. (click)

Slide 4:

A special cable connected to the CTD sends data directly from the CTD to computers on the ship so that scientists can
see the data as soon as they are collected! In the ship’s computer lab, scientists can watch output such as the graph on
the right, which shows the measurements of four variables as the CTD was lowered from the ocean surface (click) to
1100 m depth (click). The four lines on the graph each refer to a different variable, two of which of course are
temperature and salinity. Sometimes, a CTD is outfitted with extra sensors to measure variables such as oxygen (click)
and fluorescence (click). The fluorometer measures the amount of chlorophyll in a sample and provides an estimate of
phytoplankton abundance. Why would scientists care to measure how many phytoplankton are in the ocean?! (click)

Slide 5:

Phytoplankton are tiny plant-like organisms that serve as food for zooplankton and small fish, which in turn are eaten by
larger fish, birds, and mammals. Thus, without phytoplankton, the entire marine food web would collapse! (click)

Slide 6:

But phytoplankton do even more than provide food for the oceans (click). When they convert carbon dioxide, water,
and nutrients into organic matter, they also supply us with over half of the oxygen that we breathe.

When these cells respire (click), or when they die and decompose (click), they return essential nutrients back into the
ocean, where these nutrients will rapidly be consumed by other phytoplankton. (click)

Slide 7:

Allin all, phytoplankton (click) are critical for cycling chemicals such as carbon, oxygen, and nitrogen. We’re going to
spend some time looking at nitrogen compounds in particular, because they are important nutrients required by every
living thing. For example, nitrogen is used to build critical molecules, such as DNA. (click)



Slide 8:

To recap, let’s see how phytoplankton fit into the bigger picture of nutrient cycling. Solar energy is transformed into
chemical energy (click) by phytoplankton during photosynthesis.

Phytoplankton provide food (click) for other organisms, and they also respire and eventually decompose (click). All
three processes release organic waste (click), which consists of molecules such as lipids, sugars, and proteins. Organic
matter is a rich source of energy (click) for bacteria, which break the matter down (click) and return the nutrients back
into the system (click) for other cells to use. (click)

Slide 9:

Nutrient cycling is a subject of active research, especially for programs like the Hawai‘i Ocean Time-series, or HOT (click).
A time-series is a study of one or more variables over time. The HOT program was started over 20 years ago to study
long- term changes in the biology, physics, and chemistry of the Pacific Ocean. (click)

Slide 10:

The main research site of the HOT program is a location in the North Pacific Ocean called Station ALOHA (click). Station
ALOHA is located 60 miles north of the island of O‘ahu, and scientists have been going on four-day cruises to this site
almost every month since 1988. So far, there have been over 200 HOT cruises, during which scientists and students
measure variables such as pH, nutrients, temperature, and biological productivity. (click)

Slide 11:

These data are available online for public access via the (click) Hawai‘i Ocean Time-series Data Organization and
Graphical System (or HOT-DOGS). HOT-DOGS is easy to use and allows you to visualize many different variables.
Horizontal profiles and vertical depth profiles can be used to explore a wide range of research questions. For example,
from the menu at the top of the HOT-DOGS website, we can select a horizontal profile (click) (click)

Slide 12:

...to see how average (click) oxygen concentrations change over time (click). This type of output is great for looking at
long-term trends, but there are so many data points that it’s hard to interpret, so let’s change the grouping (click).
(click)

Slide 13:

By changing the grouping, to year (click), month (click), or season (click), it's much easier to see, for example, that there
was a peak (click) in oxygen in 1991 and that oxygen is highest (click) in the spring and lowest in the winter. Such
observations of the data allow us to ask questions about what processes are occurring in the ocean to create such
events or patterns. (click)

Slide 14:

Before you go online to get a taste of HOT-DOGS, let’s review what we’ve learned (click):
e ACTDis one of many instruments that scientists use to collect data about the ocean.
e CTD’s can be outfitted with extra sensors to collect data about phytoplankton (click), which are important for
feeding the marine food web, providing oxygen, and cycling nutrients.
* We perform long-term studies to be able to observe changes to the ocean over time (click). We study time-
series data to better understand ocean processes and to predict how marine ecosystems will respond to
disturbance, such as human additions of carbon dioxide to the atmosphere and ocean. (END)



Name:

Period:

STUDENT WORKSHEET — POWERPOINT
Lesson 3: Using Data to Explore Ocean Processes

What three variables does a CTD measure? (Hint: what do the letters CTD stand for?)

What are the bottles that surround a CTD used for?

Using words and/or chemical symbols, fill in the blank spaces of the reaction for photosynthesis:

Nitrate is an essential nutrient used to make important molecules such as

The process in which bacteria break down organic matter and regenerate nutrients for phytoplankton to use is
referred to as

a. photosynthesis
b. absorption
c. decomposition
d. dissolution

A study that measures how environmental variables change over time is called a

A horizontal temperature profile allows you to study how temperature changes . (Circle one.)

over time with depth



TEACHER ANSWER KEY to STUDENT WORKSHEET — POWERPOINT
Lesson 3: Using Data to Explore Ocean Processes

1. What three variables does a CTD measure? (Hint: what do the letters CTD stand for?)

Email kits@soest.hawaii.edu to request a

completed teacher answer key. Please
include name, school and grade(s) taught in
your request. Mahalo!

2. What are the bottles that surround a CTD used for?

3. Using words and/or chemical symbols, fill in the blank spaces of the reaction for photosynthesis:

4. Nitrate is an essential nutrient used to make important molecules such as

5. The process in which bacteria break down organic matter and regenerate nutrients for phytoplankton to use is
referred to as

a. photosynthesis
b. absorption
c. decomposition
d. dissolution

6. A study that measures how environmental variables change over time is called a

7. A horizontal temperature profile allows you to study how temperature changes . (Circle one.)

over time with depth



Name: Period: Group Member(s):

STUDENT WORKSHEET — HOT-DOGS
Lesson 3: Using Data to Explore Ocean Processes

Now, you will investigate data collected at Station ALOHA by the Hawai‘i Ocean Time-series (HOT) program to
determine how different variables (temperature, phytoplankton, and nutrients) change over time. HOT cruises have
been operating almost every month since October 1988, so you have a long-term dataset to work with.

Part 1: Temperature

1. InPart 1, you will determine which season has the warmest water temperatures in the upper ocean (0—200 m)
at Station ALOHA. First, generate a hypothesis by circling one of the options below to complete the following
sentence.

If we measured water temperatures at Station ALOHA over an entire year, we would expect water temperature
to be warmest in the

spring summer fall winter

Explain your answer.

2. Navigate to http://hahana.soest.hawaii.edu/hot/hot-dogs/ to use the Hawai‘i Ocean Time-series Data
Organization and Graphical System (HOT-DOGS).

3. From the menu at the top of the screen, go to Horizontal Profiles > Time-Series > Bottle.

4. Change the Function option from Integral to Mean/StDev. There have been over 200 HOT cruises to Station
ALOHA since 1988, with approximately ten cruises per year. By selecting the Mean/StDev option, the program
will display the average water temperature (with standard deviation) for each cruise.

5. Leave the remaining fields as they are and click on Submit Query. Please allow time for the graph to load.

6. The figure output should look like the graph below. This graph displays the average water temperature of the
upper 200 m in the ocean over a 20-year period. The vertical lines above and below each data point indicate
variability about the average, this is a measure called standard deviation. The x-axis represents time in years,
and the y-axis represents temperature in International Temperature Scale (ITS-90) units. ITS-90 is a precise
measurement of temperature and, for our purposes, can be regarded as equivalent to degrees Celsius (°C).
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7. Briefly study the figure. Does this figure help you test your prediction as to which season will have the highest
water temperature? Explain your answer.

8. Go Back one page on your Internet browser.

9. Change the Grouping option to Month. This tells the HOT-DOGS program to display the average temperature by
the month sampled rather than the date of the cruise. Click on Submit Query. Please allow time for the graph
to load.

10. Draw the resulting graph on the grid below. To make it easier, do not include the standard deviation bars for
each point. Label your axes, and include units if applicable.

11. Based on these data, which month has the highest average water temperature at Station ALOHA?

12. Go Back one page on your Internet browser.

13. Change the Grouping option to Season. This tells the HOT-DOGS program to display the average temperature
by the season sampled rather than the month of the cruise. Click on Submit Query. Please allow time for the
graph to load.

14. Draw the resulting graph on the grid below. Again, do not include the standard deviation bars. Label your axes,
and include units if applicable.

15. Based on these data, which season has the highest average water temperature at Station ALOHA? How does
this compare with your hypothesis?

16. Why do you think the average water temperature is the highest during this season?



17. Itis important to recognize that how you graph your data is critical, as it can affect how you interpret the results
and the conclusions that you make. Use your three graphs to answer the questions below. For each question,
indicate which graph you used AND explain why you chose that graph.

a. Over what part of the year does the ocean show the least variation in temperature? Which graph did you
use to answer the question? Why did you choose that graph?

b. In general, does it appear that the ocean is getting warmer, cooler, or staying the same? Which graph did
you use to answer the question? Why did you choose that graph?

Part 2: Phytoplankton

18. In Part 2, you will investigate which season has the highest phytoplankton abundance in the upper ocean at
Station ALOHA. Remember that phytoplankton are like plants and have chlorophyll to conduct photosynthesis.
Therefore, by measuring chlorophyll, we can estimate the amount of phytoplankton in the ocean. First,
generate a hypothesis by circling one of the options below to complete the following sentence.

If we measured chlorophyll a concentrations over an entire year, then we would expect chlorophyll
concentrations to be highest in the

spring summer fall winter

Explain your answer.

19. Go Back one page on your Internet browser.

20. Change the Operator to TD-700 Chlorophyll a. (Chlorophyll a is the main type of chlorophyll required for
photosynthesis to occur.)

21. Click on Submit Query and draw the resulting graph on the grid below. To make it easier, do not include the
standard deviation bars for each point. Label your axes, and include units if applicable. Please allow time for
the graph to load.

22. According to the graph, which season has the highest chlorophyll a concentration at Station ALOHA? How does
this compare to your hypothesis?



Part 3: Nutrients

23.

24.
25.
26.

27.

28.

29.

Nitrogen is an essential nutrient for phytoplankton growth. In Part 3, you will investigate how nitrogen (which is
most commonly measured in the ocean as nitrate and nitrite combined) varies seasonally in the upper ocean at
Station ALOHA. First, generate a hypothesis by circling one of the options below to complete the sentence.

If we measured nitrate and nitrite concentrations over an entire year, then we would expect nitrogen
concentrations to be lowest in the

spring summer fall winter

Explain your answer.

Go Back one page on your Internet browser.

Change the Operator to Nitrate + Nitrite.

Click on Submit Query and draw the resulting graph on the grid below. To make it easier, do not include the
standard deviation bars for each point. Label your axes, and include units if applicable. Please allow time for
the graph to load.

Which season had the lowest concentration of nitrogen at Station ALOHA? How does this compare with your
hypothesis?

Why do you think you would observe the lowest nitrogen concentration during this season at Station ALOHA?

Notice that nutrients gradually increase from the summer to winter and reach their maximum in the spring.
a. Circle the process that is responsible for regenerating nitrogen at Station ALOHA.

Photosynthesis Precipitation Decomposition of organic matter Weathering of rocks
b. What type of organism is responsible for this process? Circle your answer.

Bacteria Fungi Fish Coral



TEACHER ANSWER KEY to STUDENT WORKSHEET — HOT-DOGS
Lesson 3: Using Data to Explore Ocean Processes

For this lesson, you will investigate data collected by the Hawai‘i Ocean Time-series (HOT) program over the past 20
years to determine how different variables (temperature, phytoplankton, and nutrients) change with the seasons at
Station ALOHA in the North Pacific Ocean.

Part 1: Temperature

1.

" Ires in the upper ocean (0-200 m)
below to complete the following

In Part 1, you will determine

at Station ALOHA. First, gen
sentence. completed teacher answer key. Please

Email kits@soest.hawaii.edu to request a

include name, school and grade(s) taught in

If we measured water tempe ien we would expect water

our request. Mahalo!
temperature to be warmest y 9

spring summer fall winter

Explain your answer.

Navigate to http://hahana.soest.hawaii.edu/hot/hot-dogs/ to use the Hawai‘i Ocean Time-series Data
Organization and Graphical System (HOT-DOGS).

From the menu at the top of the screen, go to Horizontal Profiles > Time-Series > Bottle.

Change the Function option to Mean/StDev. There have been over 200 HOT cruises to Station ALOHA since
1988, with approximately ten cruises per year. By selecting the Mean/StDev option, the program will display the
average water temperature (with standard deviation) for each cruise.

Leave the remaining fields as they are and click on Submit Query. Please allow time for the graph to load.

The figure output should look like the graph below. This graph displays the average water temperature of the
upper 200 m in the ocean over a 20-year period. The vertical lines above and below each data point indicate
variability about the average, a measure called standard deviation. The x-axis represents time in years, and the
y-axis represents temperature in International Temperature Scale (ITS-90) units. ITS-90 is a precise
measurement of temperature and, for our purposes, can be regarded as equivalent to degrees Celsius (°C).
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7. Briefly study the figure. Does the figure above help you test your prediction as to which season will have the

highest water temperature? Explain your answer.



8. Go Back one page on your Internet browser.

9. Change the Grouping option to Month. This tells the HOT-DOGS program to display the average temperature by
the month sampled rather than the date of the cruise. Click on Submit Query. Please allow time for the graph
to load.

10. Draw the resulting graph on the grid below. To make it easier, do not include the standard deviation bars for
each point. Label your axes, and include units if applicable.

Email kits@soest.hawaii.edu to request a

completed teacher answer key. Please
include name, school and grade(s) taught in
your request. Mahalo!

11. Based on these data, which month has the highest average water temperature at Station ALOHA?

12. Go Back one page on your Internet browser.
13. Change the Grouping option to Season. This tells the HOT-DOGS program to display the average temperature
by the season sampled rather than the month of the cruise. Click on Submit Query. Please allow time for the

graph to load.
14. Draw the resulting graph on the grid below. Again, do not include the standard deviation bars. Label your axes,
and include units if applicable.

15. Based on these data, which season has the highest average water temperature at Station ALOHA? How does
this compare with your hypothesis?

16. Why do you think the average water temperature is the highest during this season?



17.

It is important to recognize that how you graph your data is critical, as it can affect how you interpret the results
and the conclusions that you make. Use your three graphs to answer the questions below. For each question,
indicate which graph you used AND explain why you chose that graph.

a. Over what part of the year does the ocean show the least variation in temperature? Which graph did you
use to answer the question? Why did you choose that graph?

b. In general, does it appear that the ocean is getting warmer, cooler, or staying the same? Which graph did
you use to answer the question? Why did you choose that graph?

Part 2: Phytoplankton

18.

19.
20.

21.

In Part 2, you will investigate which season has the highest phytoplankton abundance in the upper ocean at
Station ALOHA. Remember that phytoplankton are like plants and have chlorophyll a to conduct
photosynthesis. Therefore, by measuring chlorophyll, we can estimate the amount of phytoplankton in the
ocean. First, generate a hypothesis by circling one of the options below to complete the following sentence.

If we measured chlorophyll a concentrations over an entire year, then we would expect chlorophyll a
concentrations to be highest in the

spring summer fall winter

Explain your answer.

Go Back one page on your Internet browser.

Change the Operator to TD-700 Chlorophyll a. (Chlorophyll a is the main type of chlorophyll required for
photosynthesis to occur.)

Click on Submit Query and draw the resulting graph on the grid below. To make it easier, do not include the
standard deviation bars for each point. Label your axes, and include units if applicable. Please allow time for
the graph to load.

Email kits@soest.hawaii.edu to request a

completed teacher answer key. Please
include name, school and grade(s) taught in
your request. Mahalo!



22. According to the graph, which season has the highest chlorophyll a concentration at Station ALOHA? How does
this compare to your hypothesis?

Part 3: Nutrients

23. Nitrogen is an essential nutrient for phytoplankton growth. In Part 3, you will investigate how nitrogen (which is
most commonly measured in the ocean as nitrate and nitrite combined) varies seasonally in the upper ocean at
Station ALOHA. First, generate a hypothesis by circling one of the options below to complete the sentence.

If we measured nitrate and nitrite concentrations over an entire year, then we would expect nitrogen
concentrations to be lowest in the

spring summer fall winter

Explain your answer.

24. Go Back one page on your Internet browser.

25. Change the Operator to Nitrate + Nitrite.

26. Click on Submit Query and draw the resulting graph on the grid below. To make it easier, do not include the
standard deviation bars for each point. Label your axes and include units. Please allow time for the graph to
load.

Email kits@soest.hawaii.edu to request a

completed teacher answer key. Please
include name, school and grade(s) taught in
your request. Mahalo!

27. Which season had the lowest concentration of nitrogen at Station ALOHA? How does this compare with your
hypothesis?

28. Why do you think you would observe the lowest nitrogen concentration during this season at Station ALOHA?

29. Notice that nutrients gradually increase from the summer to winter and reach their maximum in the spring.
a. Circle the process that is responsible for regenerating nitrogen at Station ALOHA.
Photosynthesis Precipitation Decomposition of organic matter Weathering of rocks
b. What type of organism is responsible for this process? Circle your answer.

Bacteria Fungi Fish Coral



TEACHER GUIDE
Lesson 4: Nutrients and Ocean Circulation

Time Required: 70 minutes. Advance preparation requires an additional 30—60 minutes. The optional extension activity
will require ~30 minutes.

Structure: This Excel-based lesson integrates and tests multiple principles about ocean circulation, biogeochemistry, and
visualizing and interpreting data. First, students view a short PowerPoint presentation (5 minutes). Then, using online
databases of oceanographic time-series data in the Atlantic and Pacific Oceans, students graph, analyze, and interpret
data to learn about nutrient concentrations in different parts of the world (~50-60 minutes). The lesson begins and
ends with students completing a pre- and post- survey to assess learning (5 minutes each). An optional data-extraction
extension activity can be done before or after this lesson, or can be completed as homework.

Materials: (Paper materials contained in binder are shown in BOLD CAPS)

1.

W ~NOU B WN

OCEAN CONVEYOR BELT SURVEY - Lesson 4

TEACHER ANSWER KEY to OCEAN CONVEYOR BELT SURVEY - Lesson 4

POWERPOINT SCRIPT — Lesson 4: Nutrients and Ocean Circulation

STUDENT WORKSHEET - Lesson 4: Nutrients and Ocean Circulation (Excel 2003)

STUDENT WORKSHEET — Lesson 4: Nutrients and Ocean Circulation (Excel 2007)

TEACHER ANSWER KEY to STUDENT WORKSHEET — Lesson 4: Nutrients and Ocean Circulation
GLOSSARY

CD with narrated PowerPoint presentations

Speakers

Materials Not Included in this Kit but Needed for Lesson 4:
10. Projector
11. Student computers with MS Office Excel (required for Lesson 4) and high-speed Internet access (e.g., cable

modem, DSL, broadband)

Materials for Optional Extension Activity:
12. STUDENT INSTRUCTIONS — Lesson 4 Extension: Data Extraction (Excel 2003)
13. STUDENT INSTRUCTIONS — Lesson 4 Extension: Data Extraction (Excel 2007)

Advance Preparation:

1.

There are two versions of the STUDENT WORKSHEET — Lesson 4: Nutrients and Ocean Circulation, one for Excel
2003 and one for Excel 2007. Photocopy or print the version that corresponds to your version of Excel (one per
student). Note: These instructions are designed for PC computers. A TEACHER ANSWER KEY is provided for your
convenience.

Instruct your students to download the Excel spreadsheet HOT-BATS from
http://cmore.soest.hawaii.edu/education/teachers/documents/HOT-BATS.xIs.

Note: If you prefer, you can pre-load the file onto each student computer as follows: Locate the HOT-BATS file on
the CD, load the file onto one computer by dragging it from the CD onto the desktop, copy it onto a USB flash
drive, and then copy it onto each computer.

Photocopy or print OCEAN CONVEYOR BELT SURVEY — Lesson 4 (two copies per student). This serves as both a
pre-survey and post-survey for this lesson.

You may have already distributed the GLOSSARY to students during a previous lesson. If not, photocopy or print
the GLOSSARY (one per student).

A short, narrated PowerPoint presentation entitled Lesson 4_Nutrients and Ocean Circulation_NARRATED can
also be found on the CD. Load this file onto your computer by dragging it from the CD onto the desktop.



10.

11.

Speakers are included in the kit for playing the narrated presentation. Refer to the laminated manual attached
to the speaker storage case for set-up instructions.

If you prefer to present the information yourself, load the non-narrated version, Lesson 4_Nutrients and Ocean
Circulation_NON-NARRATED. POWERPOINT SCRIPT - Lesson 4: Nutrients and Ocean Circulation is included as a
guide.

Once the presentation has been loaded, eject the CD and return it to the binder.

Obtain access to enough computers for the students to work in pairs or individually, and identify which version
of Excel is installed.

Students will investigate two data sets: (1) data collected at a location in the North Pacific near Hawai‘i, by the
Hawai‘i Ocean Time-series (HOT) program; and (2) data collected at a site in the North Atlantic near Bermuda, by

the Bermuda Atlantic Time-series (BATS) program.

Review the STUDENT WORKSHEET — Lesson 4: Nutrients and Ocean Circulation.

Instructional Procedures:

1.

Distribute one copy of OCEAN CONVEYOR BELT SURVEY - Lesson 4 to each student. Have the students check
the pre-survey box and answer the questions (allow 5 minutes).

Play the brief (~5 minute) PowerPoint presentation Lesson 4_Nutrients and Ocean Circulation_ NARRATED.

Distribute one copy of the GLOSSARY and one copy of the STUDENT WORKSHEET — Lesson 4: Nutrients and
Ocean Circulation to each student.

Depending on the number of computers available, have the students work individually or in pairs and assign
them to computer stations. Students should be able to complete the lesson without much assistance.

Assessment and Clean-up:

1.

Approximately 10 minutes before the end of class, distribute one copy of the OCEAN CONVEYOR BELT SURVEY -
Lesson 4 to each student. Have the students check the post-survey box and answer the questions. A TEACHER
ANSWER KEY is provided for your convenience.

As the students are completing their surveys, we would be grateful if you would complete the TEACHER
EVALUATION in this kit. All comments, corrections, and suggestions are very welcome. If you prefer, you can
complete the evaluation online (see TEACHER EVALUATION for website address).

Re-pack the kit for return to C-MORE. Double check that all the items are included and in their proper place by
completing the SUPPLY CHECKLIST. Please make a note of any missing, broken, or damaged items so that they
can be replaced. Please pack the kit so that the materials are stored as they were when you received them.
Please also include a copy of the students' pre- and post- surveys. Mahalo!

Extension. In Lesson 4, students use time-series data that are available online, but they do not download the data
themselves. If you would like your students to extract and process the time-series data themselves, then print or
photocopy the STUDENT INSTRUCTIONS - Lesson 4 Extension: Data Extraction that correspond to your version of Excel
(one copy for each student or pair of students working together). Time required: ~30 minutes.



~70 minutes: After viewing the PowerPoint presentation Lesson 4_Nutrients and Ocean Circulation, students work
individually or in pairs on a Excel-based lesson using data from two oceanographic time-series programs.

Pre-survey (5 minutes)
e Each student completes and turns in the OCEAN CONVEYOR BELT SURVEY - Lesson 4 (pre-survey).

PowerPoint Presentation (~5 minutes)
e Narrated PowerPoint presentation introduces vertical depth profiles and the BATS program.

Student Worksheet (50—-60 minutes)
e Students use data from two oceanographic time-series programs to create a single graph in Excel.
e Students answer questions that challenge them to integrate multiple concepts about nutrient cycling
and ocean circulation.

Post-survey (5 minutes)
e Each student completes and turns in the OCEAN CONVEYOR BELT SURVEY - Lesson 4 (post-survey).




OCEAN CONVEYOR BELT SURVEY — LESSON 4

Check one:
Pre-survey Name:

Post-survey

Directions:
This survey is both a pre- and post- survey. Put a check mark at the top of this paper next to the survey you are doing
(pre- or post- survey). Please answer each question to the best of your ability. Circle the most correct answer.

1. Deep water in the Atlantic Ocean is the water in the Pacific Ocean.
a. olderthan
b. younger than
c. thesame age as

2. Nutrients, such as phosphate and nitrate, generally have concentrations in the surface ocean
when compared to the deep ocean.
a. higher
b. lower
c. thesame

3. Inthe oceans, nutrients are regenerated and made available for phytoplankton by
a. evaporation
b. photosynthesis
C. precipitation
d. decomposition of organic matter

4. The primary producers in the marine food web are
a. sharks
b. zooplankton
c. phytoplankton
d. jellyfish

5. Oxygen concentrations, in general, are highest in the surface ocean because of
a. respiration
b. remineralization
c. photosynthesis
d. decomposition




TEACHER ANSWER KEY
OCEAN CONVEYOR BELT SURVEY — LESSON 4

Check one: Email kits@soest.hawaii.edu to request a
Pre-survey completed teacher answer key. Please Name:
Post-survey include name, school and grade(s) taught in

. . your request. Mahalo!
Directions:

This survey is both a pre- and post- survey. Put a check mark at the top of this paper next to the survey you are doing
(pre- or post- survey). Please answer each question to the best of your ability. Circle the most correct answer.

1. Deep water in the Atlantic Ocean is the water in the Pacific Ocean.
a. olderthan
b. younger than
c. thesame age as

2. Nutrients, such as phosphate and nitrate, generally have concentrations in the surface ocean
when compared to the deep ocean.
a. higher
b. lower
c. thesame

3. Inthe oceans, nutrients are regenerated and made available for phytoplankton by
a. evaporation
b. photosynthesis
C. precipitation
d. decomposition of organic matter

4. The primary producers in the marine food web are
a. sharks
b. zooplankton
c. phytoplankton
d. jellyfish

5. Oxygen concentrations, in general, are highest in the surface ocean because of
respiration

b. remineralization

c. photosynthesis

d. decomposition

o



POWERPOINT SCRIPT
Lesson 4: Nutrients and Ocean Circulation

Slide 1:

By this time, you’re familiar with the Hawai‘i Ocean Time-series and interpreting horizontal profiles of temperature,
phytoplankton, and nutrients at Station ALOHA. Now we are going to introduce vertical depth profiles at Station ALOHA
and see how ocean processes in the Pacific Ocean relate to global scales of circulation. In other words, how do oxygen
concentrations vary from the ocean surface to depth, and why? How do processes such as the formation of deep water
in the Atlantic Ocean affect nutrient cycling in the Pacific Ocean? Let’s take a look! (click)

Slide 2:

On HOT-DOGS, we can examine how a variable, such as oxygen, changes from the surface to the deep ocean by choosing
a vertical depth profile. If we select a vertical profile of oxygen (click) from the surface to 5000 m depth (click), we can
see that oxygen concentrations are highest near the ocean surface (click) where oxygen-producing phytoplankton are
most abundant and where the ocean exchanges gases with the atmosphere. Organisms that live throughout the water
consume oxygen as they feed on phytoplankton and other cells, therefore oxygen concentrations (click) decrease with
depth to about 800 m.

Deeper than 800 m (click), oxygen concentrations (click) increase with depth because the deep Pacific Ocean is supplied
with oxygen-enriched water from the Atlantic. Also, the abundance of organisms decreases with depth, so less oxygen is
consumed in the deep ocean than in the surface ocean.

The oxygen profiles of these two layers (click) appear quite different because the density differences between the upper
and deep ocean inhibit mixing. The oxygen profile for the upper ocean (click) is affected mostly by phytoplankton
productivity, gas exchange with the atmosphere, respiration, and decomposition, while the oxygen profile for the deep
ocean (click) is determined mostly by deep ocean circulation, respiration, and decomposition.

Vertical and horizontal profiles on HOT-DOGS can tell us a lot about what is happening in the North Pacific, but what
about other locations? (click)

Slide 3:

In addition to the Hawai‘i Ocean Time-series (click) in the North Pacific Ocean, there is also a long-term oceanographic
study in the Atlantic Ocean near Bermuda (click). This research program is called the Bermuda Atlantic Time-Series, or
BATS. (click)

Slide 4:

Just like the HOT program, data from the BATS program are available online. Downloading data from both sites allows
us to compare variables in the Pacific and Atlantic Oceans and to better understand large-scale ocean processes. (click)

Slide 5:

For example, you may download oxygen and depth data from both the Atlantic and Pacific Oceans and plot them in
Excel. Differences in oxygen concentrations between the Pacific and Atlantic Ocean basins are controlled by a
combination of respiration (click), decomposition, and thermohaline circulation. As you saw earlier, oxygen
concentrations in the surface ocean decrease with depth (click) because organisms have more time to consume oxygen
as they respire and feed on organic matter.

This graph of oxygen versus depth shows that deep water in the Pacific has much less oxygen than that in the Atlantic.
The surface water in the North Atlantic is oxygen-rich when it starts to sink, at which time it is considered to have an age
of zero years. As this water travels in the deep ocean current to the Pacific, more and more oxygen is removed over
time by organisms as they feed and respire. The deep water “ages” as it flows from the Atlantic to the Pacific where the
deep water resurfaces (click). Pacific deep water is several hundred years “older” than Atlantic deep water (click), and
organisms have had much more time to use up oxygen during respiration and feeding.

Now it’s your turn! Using nutrient data from the HOT and BATS programs, you will plot and compare nitrogen
concentrations in the Pacific and Atlantic Oceans. (END)



Name: Period: Group Member(s):

STUDENT WORKSHEET
Lesson 4: Nutrients and Ocean Circulation (Excel 2003)

For this lesson, you will compare nutrient concentrations in the Pacific and Atlantic Oceans by making a vertical profile
using data from the Hawai‘i Ocean Time-series (HOT) and Bermuda Atlantic Time-Series (BATS). You will then use the
graph to understand how deep ocean circulation impacts nutrient profiles in these two oceans.

1. You have explored how variables change over time. In this lesson, you are going to investigate how variables
change with depth. Below is a coordinate plane for a horizontal nitrate profile. In the space next to it, draw a
coordinate plane for a vertical nitrate profile, label the axes, and use arrows to show directions of increase.

a. Horizontal nitrate profile: b. Vertical nitrate profile:

Nitrate (umol/L) —»

Time (years) >

2. Navigate to http://hahana.soest.hawaii.edu/hot/hot-dogs/ to use the Hawai‘i Ocean Time-series Data
Organization and Graphical System (HOT-DOGS). From the menu at the top of the HOT-DOGS screen, go to
Vertical Profiles > Display > Bottle.

3. Change the X-axis option to Nitrate + Nitrite.

4. The most recent data are from cruise #204, which occurred in August 2008. Enter “204” in the box next to
Cruise #(s)/Year(s).

5. Click Submit Query. Allow time for the data to load.

6. Take alook at the graph. Notice that nitrogen concentrations in the surface ocean/transition zone (0—~900 m)
range from 0 to 42 umol/kg. On the other hand, nitrogen concentrations in the deep ocean (~900-4800 m) are
generally much higher and range from 35 to 42 umol/kg. Discuss the processes of photosynthesis,
decomposition, and mixing to explain why the deep ocean has more nutrients than the surface ocean in 2-3
comprehensive paragraphs.




O
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You will use data from the HOT and BATS programs to investigate nitrogen concentrations (as measured by
combined nitrate and nitrite). First, generate a hypothesis by circling the one of the options below to complete
the sentence.

If we measured nitrogen concentrations from the surface to depth in the Pacific and Atlantic Oceans, then we
would expect nitrogen concentrations in the Pacific to be those in the Atlantic Ocean.

the same as higher than less than

Explain your answer.

Now you are going to compile data extracted from the HOT and BATS websites and make a graph comparing
nitrogen concentrations in the Atlantic and Pacific Oceans. Check off the boxes on the left as you go to keep
track of where you are in the activity.

On your computer desktop, there may be an Excel file called HOT-BATS. If this file is not on your
desktop, your teacher may instruct you to download it from
http://cmore.soest.hawaii.edu/education/teachers/documents/HOT-BATS.xls.

Double click on HOT-BATS to open this Excel file. You will see four columns of data. The two left-
most columns are nitrogen (column A) and depth (column B) data from the HOT program, and the
two right-most columns are nitrogen (column D) and depth (column E) data from the BATS
program. Both sets of data were collected in August 2008.

i
Select columns A and B (the HOT data) and click on the colorful Graph Wizard icon ﬂ' to make a
graph.

Under the “Chart type”, select

= XY (Scatter), and then select the bottom right chart sub-type

\% . Click Next.

called Scatter with data points connected by lines without markers
Select the Series tab at the top of the window.

Click in the Name box, delete the contents of this box, and then type “HOT (Pacific)” in the empty
box.

Click Add, and in the new empty Name box, type “BATS (Atlantic)”.

In the X Values box, select the icon with the red arrow |1=_J, go to your spreadsheet, click and drag
to select cells D2—D65, and then click on the arrow icon |E|.

Repeat this procedure for the Series Y Values box, selecting cells E2—E65.

Click Next.

Select the Titles tab at the top of the Chart Options window.

In the Chart title box, type in “Comparison of nitrogen concentrations in Atlantic vs. Pacific
Oceans”.

In the Value (X) axis box, type in “Nitrate + nitrite (umol/kg)”.

In the Value (Y) axis box, type in “Depth (m)”.

Click Finish. Your graph should look like the following figure.



Comparison of nitrogen concentrations in Atlantic vs. Pacific
Oceans
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In order for the y-axis to show depth from top to bottom, you’ll need to reverse the order of the
values:

[ Right-click on the y-axis numbers, and you will get a pop up window that says Format Axis

at the top. Click on the Format Axis.

[0 Under the Scale tab, check the box in front of Values in reverse order.

[ Change the Maximum value to “5000”, and then click OK.
Get rid of the grey background by right-clicking on the grey background and selecting Format Plot
Area... from the dropdown menu. Select None under Area and click OK.
Save your file!

Draw the resulting graph on the grid below. Include a title and legend and label your axes (include units).




10. Interpret your graph. Which ocean basin has a higher nitrogen concentration? How does this compare to your
hypothesis?

11. Return to your deep ocean circulation map from Lesson 2. Label the locations of the HOT and BATS programs on
your map.

12. Why do you think one ocean basin may have more nutrients than the other? How would old versus new
seawater (deep water formation sites) differ in terms of nutrients? Why? In your answer, discuss the
importance of primary productivity and decomposition by bacteria in relation to the global conveyor belt in 2—3
comprehensive paragraphs.



Name: Period: Group Member(s):

STUDENT WORKSHEET
Lesson 4: Nutrients and Ocean Circulation (Excel 2007)

For this lesson, you will compare nutrient concentrations in the Pacific and Atlantic Oceans by making a vertical profile
using data from the Hawai‘i Ocean Time-series (HOT) and Bermuda Atlantic Time-Series (BATS). You will then use the
graph to understand how deep ocean circulation impacts nutrient profiles in these two oceans.

1. You have explored how variables change over time. In this lesson, you are going to explore how variables
change with depth. Below is a coordinate plane for a horizontal nitrate profile. In the space next to it, draw a
coordinate plane for a vertical nitrate profile, label the axes, and use arrows to show directions of increase.

a. Horizontal nitrate profile: b. Vertical nitrate profile:

Nitrate (umol/L) —»

Time (years) >

2. Navigate to http://hahana.soest.hawaii.edu/hot/hot-dogs/ to use the Hawai‘i Ocean Time-series Data
Organization and Graphical System (HOT-DOGS). From the menu at the top of the HOT-DOGS screen, go to
Vertical Profiles > Display > Bottle.

3. Change the X-axis option to Nitrate + Nitrite.

4. The most recent data are from cruise #204, which occurred in August 2008. Enter “204” in the box next to
Cruise #(s)/Year(s).

5. Click Submit Query. Allow time for the data to load.

6. Take alook at the graph. Notice that nitrogen concentrations in the surface ocean/transition zone (0—~900 m)
range from 0 to 42 umol/kg. On the other hand, nitrogen concentrations in the deep ocean (~900-4800 m) are
generally much higher and range from 35 to 42 umol/kg. Discuss the processes of photosynthesis,
decomposition, and mixing to explain why the deep ocean has more nutrients than the surface ocean in 2-3
comprehensive paragraphs.




7. You will use data from the HOT and BATS programs to investigate nitrogen concentrations (as measured by
combined nitrate and nitrite). First, generate a hypothesis by circling the one of the options below to complete
the sentence.

If we measured nitrogen concentrations from the surface to depth in the Pacific and Atlantic Oceans, then we
would expect nitrogen concentrations in the Pacific to be those in the Atlantic Ocean.

the same as higher than less than

Explain your answer.

8. Now you are going to compile data extracted from the HOT and BATS websites and make a graph comparing
nitrogen concentrations in the Atlantic and Pacific Oceans. Check off the boxes on the left as you go to keep
track of where you are in the activity.

[ Look on your computer desktop for an Excel file called HOT-BATS. Double click to open it. If this
file is not on your desktop, your teacher may instruct you to download it from
http://cmore.soest.hawaii.edu/education/teachers/documents/HOT-BATS.xlIs or to extract the
data yourself. If you are told to extract the data yourself, first complete the steps listed on
STUDENT INSTRUCTIONS - Lesson 4 Extension: Data Extraction, and then return to this page.

In the HOT-BATS file, you will see four columns of data. The two left-most columns are nitrogen
(column A) and depth (column B) data from the HOT program, and the two right-most columns are
nitrogen (column D) and depth (column E) data from the BATS program. Both sets of data were
collected in August 2008.

[J Highlight columns A and B and select the Insert menu at the top of the screen.
[0 Select Scatter “™ > Scatter with Straight Lines g Your graph should look like the following
figure.

Depth
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O In order for the y-axis to show depth with the surface at the top of the graph and getting deeper as
you go down, you'll need to reverse the order of the values. If you do not see the Chart Tools at
the top of the screen (Design, Layout, and Format), then click on your graph to highlight it.

11

O Select Layout > Axes "=* > Primary Vertical Axis > More Primary Vertical Axis Options ...
O Check the box next to Values in reverse order.
] Near the top of the same window, next to Maximum, click on Fixed.



[0 Enter “5000” in the field next to Fixed, and then click Close.

[0 Now you need to add the BATS data to your graph:

__|
~lin]

Select Design > Select Data oa:s .
Under the Legend Entries (Series) box, click Add.
In the Series name box, type “BATS (Atlantic)”.

Ooooao

In the Series X Values box, select the icon with the red arrow @, go to your spreadsheet,

click and drag to select cells D2—-D65, and then click on the arrow icon @.

] Repeat this procedure for the Series Y Values box, selecting cells E2—E65; click OK.
0 While the Select Data Source box is still open, change the name of your HOT data series:

[0 Under the Legend Entries (Series) box, click on the Depth series, and then click Edit.

I In the Series name box, type “HOT (Pacific)” and click OK. Click OK again.

[ You are ready to add chart and axis titles to your graph. If you do not see the Chart Tools at the
top of the screen (Design, Layout, and Format), then click on your graph to highlight it.

[0 Select Layout>Chart Title>Above Chart.

[ Click anywhere in the Chart Title box that is now above your graph. Highlight Chart Title
and then type in “Comparison of nitrogen concentrations in Atlantic vs. Pacific Oceans”.
Click anywhere outside the Chart title box .

While still in Layout select Axis Titles > Primary Horizontal Axis Title > Title Below Axis.
Highlight Axis Title and then type in “Nitrate + Nitrite (umol/kg)”.

While still in Layout select Axis Titles > Primary Vertical Axis Title > Rotated Title.

Click anywhere in the Axis Title box that is now along your y-axis on your graph. Highlight
Axis Title, and then type in “Depth (m)”.

1 Save your file!

OoooOod

9. Draw the resulting graph on the grid below. Include a title and legend and label your axes (include units).




10. Interpret your graph. Which ocean basin has a higher nitrogen concentration? How does this compare to your
hypothesis?

11. Return to your deep ocean circulation map from Lesson 2. Label the locations of the HOT and BATS programs on
your map.

12. Why do you think one ocean basin may have more nutrients than the other? How would old versus new
seawater (deep water formation sites) differ in terms of nutrients? Why? In your answer, discuss the
importance of primary productivity and decomposition by bacteria in relation to the global conveyor belt in 2—-3
comprehensive paragraphs.



TEACHER ANSWER KEY to STUDENT WORKSHEET
Lesson 4: Nutrients and Ocean Circulation

For this lesson, you will compare nutrient concentrations in the Pacific and Atlantic Oceans by making a vertical profile
using data from the Hawai‘i Ocean Time-series (HOT) and Bermuda Atlantic Time-Series (BATS). You will then use the
graph to understand how deep ocean circulation impacts nutrient profiles in these two oceans.

1. You have explored how variables change over time. In this lesson, you are going to explore how variables
change with depth. Below is a coordinate plane for a horizontal nitrate profile. In the space next to it, draw a
coordinate plane for a vertical nitrate profile, label the axes, and use arrows to show directions of increase.

a. Horizontal nitrate profile: b. Vertical nitrate profile:
T Email kits@soest.hawaii.edu to request a
3 completed teacher answer key. Please
TE’ include name, school and grade(s) taught in
g your request. Mahalo!
o
§

Time (years) >

2. Navigate to http://hahana.soest.hawaii.edu/hot/hot-dogs/ to use the Hawai‘i Ocean Time-series Data
Organization and Graphical System (HOT-DOGS). From the menu at the top of the HOT-DOGS screen, go to
Vertical Profiles > Display > Bottle.

3. Change the X-axis option to Nitrate + Nitrite.

4. The most recent data are from cruise #204, which occurred in August 2008. Enter “204” in the box next to
Cruise #(s)/Year(s).

5. Click Submit Query. Allow time for data to load.

6. Take alook at the graph. Notice that nitrogen concentrations in the surface ocean/transition zone (0-~900 m)
range from 0 to 42 umol/kg. On the other hand, nitrogen concentrations in the deep ocean (~900-4800 m) are
generally much higher and range from 35 to 42 umol/kg. Discuss the processes of photosynthesis,
decomposition, and mixing to explain why the deep ocean has more nutrients than the surface ocean in 2-3
comprehensive paragraphs.




10.

11.

12.

You will use data from the HOT and BATS programs to investigate nitrogen concentrations (as measured by
combined nitrate and nitrite). First, generate a hypothesis by circling the one of the options below to complete
the sentence.

If we measured nitrogen concentrations from the surface to depth in the Pacific and Atlantic Oceans, then we
would expect nitrogen concentrations in the Pacific to be those in the Atlantic Ocean.

the same as higher than less than
Explain your answer.

Now you are going to compile data extracted from the HOT and BATS websites and make a graph comparing
nitrogen concentrations in the Atlantic and Pacific Oceans. Student instructions have been omitted here.

Draw the resulting graph on the grid below. Include a title, legend and label your axes (include units).

Email kits@soest.hawaii.edu to request a

completed teacher answer key. Please
include name, school and grade(s) taught in
your request. Mahalo!

Interpret your graph. Which ocean basin has a higher nitrogen concentration? How does this compare to your
hypothesis?

Return to your deep ocean circulation map from Lesson 2. Label the locations of the HOT and BATS programs on
your map.

Why do you think one ocean basin may have more nutrients than the other? How would old versus new
seawater (deep water formation sites) differ in terms of nutrients? Why? In your answer, discuss the
importance of primary productivity and decomposition by bacteria in relation to the global conveyor belt in 2—-3
comprehensive paragraphs.



STUDENT INSTRUCTIONS
Lesson 4 Extension: Data Extraction (Excel 2003)

Can | go to the online time-series databases and download the data myself? Yes, but you'll have to process it first!
These instructions walk you through the steps of extracting and processing data from the Hawai‘i Ocean Time-series
(HOT) and Bermuda Atlantic Time-Series (BATS). Check off the boxes as you go to keep track of where you are.

HOT Program
A. Extracting the data

(]
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Navigate to http://hahana.soest.hawaii.edu/hot/hot-dogs/ to use the Hawai‘i Ocean Time-series
Data Organization and Graphical System (HOT-DOGS).
From the menu at the top of the screen, go to Vertical Profiles > Display > Bottle.
In the Cruise #(s) / Year(s) box, enter “204” (for the August 2008 cruise).
Leave Station #(s) as 2.
Select X- and Y-axis variables:
0 X-axis: Nitrate + Nitrite
O Y-axis: Pressure (equivalent to depth in meters)
Set Output type as text. Leave other boxes blank.
Click Submit Query. Allow time for data to load. The data will be displayed in the following

format:
jday, crn, stn, cast, ros, nit, press
#, #, #, #, #, umol/kg, dbar

7260, 204, 2, 3, 24, 0.02, 7.0
7260, 204, 2, 3, 23, 28.86, 500.7
7260, 204, 2, 3, 22, 40.56, 750.6
7260, 204, 2, 3, 21, 41.42, 999.5
7260, 204, 2, 3, 20, 41.51, 1199.9
7260, 204, 2, 3, 19, 41.45, 1401.4
7260, 204, 2, 3, 18, 40.97, 1600.8
7260, 204, 2, 3, 17, 40.38, 1800.3
7260, 204, 2, 3, 16, 40.02, 2000.4
7260, 204, 2, 3, 15, 39.58, 2200.2
7260, 204, 2, 3, 14, 39.16, 2399.8
7260, 204, 2, 3, 13, 38.71, 2599.2
7260, 204, 2, 3, 12, 38.25, 2800.3
7260, 204, 2, 3, 11, 37.78, 2999.4
7260, 204, 2, 3, 10, 37.63, 3199.6
7260, 204, 2, 3, 9, 36.97, 3399.2
7260, 204, 2, 3, 8, 36.90, 3600.9
7260, 204, 2, 3, 7, 36.59, 3800.9
7260, 204, 2, 3, 6, 36.21, 3999.8
7260, 204, 2, 3, 5, 36.04, 4200.7
7260, 204, 2, 3, 4, 35.97, 4399.7
7260, 204, 2, 3, 3, 36.13, 4500.4
7260, 204, 2, 3, 2, 36.11, 4601.0
7260, 204, 2, 3, 1, 35.79, 4806.2
7260, 204, 2, 4, 24, 0.04, 6.2
7260, 204, 2, 4, 23, 0.08, 50.9
7260, 204, 2, 4, 22, 0.08, 75.9
7260, 204, 2, 4, 21, 0.06, 111.4
7260, 204, 2, 4, 20, 0.58, 149.1
7260, 204, 2, 4, 19, 2.04, 207.4
7260, 204, 2, 4, 18, 4.95, 258.0
7260, 204, 2, 4, 17, 8.12, 302.0
7260, 204, 2, 4, 16, 11.61, 344.8
7260, 204, 2, 4, 15, 15.52, 380.7
7260, 204, 2, 4, 14, 22.14, 437.4
7260, 204, 2, 4, 13, 28.99, 504.5



Highlight all of displayed data, including titles (CTRL+A), and copy it (CTRL+C). The data should
now be highlighted and on the clipboard.

Open a Notepad document (to find Notepad, go to Start > All Programs > Accessories > Notepad).
Paste the data into Notepad (CTRL+V).

Save the data (CTRL+S) as “HOT” in a location specified by your teacher. You may need to click on
Browse Folders in the lower left of the window to find the location to save your work.

ooo 0O

B. Importing the data into Excel

O Open Excel. Click on the File menu, and then click Open. If you cannot see Open, click on ¥ to
expand the file menu.

In the Open dialog box, click where it says All Microsoft Office Excel Files at the bottom of the box,
select All Files from the Files of type field.

Locate your Notepad document labeled “HOT”, select it, and then click Open.

A Text Import Wizard box will open. Select Delimited for Original Data Type, and then click Next.
Add Comma as a delimiter by checking the box next to Comma, then click Finish.

Once the data have been imported, save the file as an Excel Workbook. Click File and select Save
As. In the Save As dialog box, select Microsoft Office Excel Workbook under the Save as Type
menu. If you are asked to replace “HOT.txt”, click yes.

o000 O

BATS Program
A. Extracting the data
[0 Navigate to http://bats.bios.edu/ to access the online data system.
O In the left-hand menu, click on Bottle Data.
[0 Change the following:
0 Enter Cruise Number: “10238” (for the August 2008 cruise)
0 Inthe Discrete Data section, check all of the following:
= Deployed: Year Month Day
= Depth (m) (already checked) and Nitrate + Nitrite (umol/kg)
0 Leave other settings as they are.
[ Scroll to the bottom of the page and click Get Bottle Data.
[0 A table called Details of Extracted Bottle Data will appear. At the bottom of the page, select Click
Here to View Data.

The data will be displayed in a similar format to that of the HOT data shown above, but notice that
there are different columns. Because we are comparing the same type of data from different sources,
there are differences in the way the samples are numbered and displayed. Later, we will pull out just
the data that we need.

[ Highlight the displayed data (CTRL+A) and copy it (CTRL+C). The data should now be highlighted
and on the clipboard.

Open a Notepad document (to find Notepad, go to Start > All Programs > Accessories > Notepad).
Paste the data into Notepad (CTRL+V).

Save the file (CTRL+S) as “BATS” in a location specified by your teacher.

ooad



B. Importing the data into Excel

ooooOo OO0

Open a new Excel workbook. Under the File menu, click Open.

In the Open dialog box, click where it says All Microsoft Office Excel Files at the bottom of the box,
select All Files from the Files of type field.

Locate your Notepad document labeled “BATS”, select it, and then click Open.

A Text Import Wizard box will open. Select Delimited for Original Data Type, then click Next.

Add Comma as a delimiter by checking the box next to Comma, then click Finish.

Once the data have been imported, save the file as an Excel Workbook. Click File and select Save
As. In the Save As dialog box, select Microsoft Office Excel Workbook under the Save as Type
menu. If you are asked to replace “BATS.txt”, click yes.

Note: In column A, you may see the data displayed as exponents (1.02E+08) because the numbers are
longer than the column widths. To see the entire number, put your cursor on the line between columns A

and B so that the cursor looks like this: ‘+’, and then double click to automatically adjust column width.

C. Cleaning up the data in Excel

We extracted the data from every CTD cast during BATS cruise 10238, but nitrogen samples were not
collected for every bottle from every cast. The BATS data system reports depths without a measured
nitrogen concentration as -9.99. Before graphing the BATS data in Excel, the depths with no nitrogen data
need to be removed.
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Select columns A-D by placing your cursor over the letter at the top of column A so that the cursor
looks like this: 8. Then click on “A” and drag the cursor to the right to highlight columns A-D.
Click on the Data menu at the top of the screen, and then select Sort.

In the Sort by drop box, click on the arrow ¥ | next to the box that says %ld and select NO3. Then
click OK.

Now you need to delete rows 2 through 207 (because they are all -9.99):

[J Put your cursor on row 2 (the number 2 on the left-hand side) so that it looks like this: =
O Click and drag the cursor down to highlight rows 2 through 207.
[J Right-click on the row labels (the numbers on the left-hand side) and select Delete.

While all the data is still highlighted, sort the data by depth:

O

[ Click on Data > Sort
I Inthe Sort by drop box, select Depth, and then click OK.

Save your file!



HOT & BATS: Organizing the data in Excel
Now you are going to compile the data extracted from the HOT and BATS websites.
A. Compiling the data into one spreadsheet
] Open a new Excel worksheet, by clicking New under the File menu. If asked, select the Blank
Worksheet.
I Save the file as “HOT-BATS”.

Return to your “HOT” Excel worksheet, and copy the nit (Nitrogen) and press (Pressure) columns:
[ Select both columns by placing your cursor over the letter at the top of column F so that it
looks like this: 8. Then click and drag the cursor to the right to highlight both columns F
and G.
[0 Copy the columns (CTRL+C), and then go to your new “HOT-BATS” spreadsheet, select the
first two columns, and paste the data (CTRL+V).

Remove the cells in the second row that contain umol/Kg and dbar:
[ Put your cursor on row 2 (the number 2 on the left-hand side) so that it looks like this: =
[ Right-click and select delete.

[J Rename the columns: click on cell A1 and type “HOT”, and then click on cell B1 and type “Depth”.
Remember that in this case, press (pressure) is equivalent to depth in meters.

Return to your “BATS” excel spreadsheet and copy the NO3 (Nitrate + Nitrite) column:
[ Select the column by placing your cursor over the letter at the top of column D, and left
click.
[ Copy the column (CTRL+C), and then go to your new “HOT-BATS” worksheet, select column
D, and paste the data (CTRL+V).

[0 Rename the column “BATS.”

[ Copy (CTRL+C) the Depth column (column C in your BATS spreadsheet) and paste it (CTRL+V) into
column E in your “HOT-BATS” spreadsheet.

[0 Save your work (CTRL+S).

B. Making a graph
Now that you have successfully imported and filtered the data from both the HOT and BATS websites, you
can make a graph comparing the data from these two studies.

Sort your HOT data according to depth:
[ Select columns A and B and select Data > Sort.
0 Under Sort by, choose Depth and select OK.

Now you are ready to return to step #8 on your STUDENT WORKSHEET - Lesson 4: Nutrients and Ocean
Circulation (Excel 2003).



STUDENT INSTRUCTIONS
Lesson 4 Extension: Data Extraction (Excel 2007)

Can | go to the online time-series databases and download the data myself? Yes, but you'll have to process it first!
These instructions walk you through the steps of extracting and processing data from the Hawai‘i Ocean Time-series
(HOT) and Bermuda Atlantic Time-Series (BATS). Check off the boxes as you go to keep track of where you are.

HOT Program
A. Extracting the data

(]
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Navigate to http://hahana.soest.hawaii.edu/hot/hot-dogs/ to use the Hawai‘i Ocean Time-series
Data Organization and Graphical System (HOT-DOGS).
From the menu at the top of the screen, go to Vertical Profiles > Display > Bottle.
In the Cruise #(s) / Year(s) box, enter “204” (for the August 2008 cruise).
Leave Station #(s) as 2.
Select X- and Y-axis variables:
[0 X-axis: Nitrate + Nitrite
[ Y-axis: Pressure (equivalent to depth in meters)
Set Output type as text. Leave other boxes blank.
Click Submit Query. Allow time for data to load. The data will be displayed in the following

format:
jday, crn, stn, cast, ros, nit, press
#, #, #, #, #, umol/kg, dbar

7260, 204, 2, 3, 24, 0.02, 7.0
7260, 204, 2, 3, 23, 28.86, 500.7
7260, 204, 2, 3, 22, 40.56, 750.6
7260, 204, 2, 3, 21, 41.42, 999.5
7260, 204, 2, 3, 20, 41.51, 1199.9
7260, 204, 2, 3, 19, 41.45, 1401.4
7260, 204, 2, 3, 18, 40.97, 1600.8
7260, 204, 2, 3, 17, 40.38, 1800.3
7260, 204, 2, 3, 16, 40.02, 2000.4
7260, 204, 2, 3, 15, 39.58, 2200.2
7260, 204, 2, 3, 14, 39.16, 2399.8
7260, 204, 2, 3, 13, 38.71, 2599.2
7260, 204, 2, 3, 12, 38.25, 2800.3
7260, 204, 2, 3, 11, 37.78, 2999.4
7260, 204, 2, 3, 10, 37.63, 3199.6
7260, 204, 2, 3, 9, 36.97, 3399.2
7260, 204, 2, 3, 8, 36.90, 3600.9
7260, 204, 2, 3, 7, 36.59, 3800.9
7260, 204, 2, 3, 6, 36.21, 3999.8
7260, 204, 2, 3, 5, 36.04, 4200.7
7260, 204, 2, 3, 4, 35.97, 4399.7
7260, 204, 2, 3, 3, 36.13, 4500.4
7260, 204, 2, 3, 2, 36.11, 4601.0
7260, 204, 2, 3, 1, 35.79, 4806.2
7260, 204, 2, 4, 24, 0.04, 6.2
7260, 204, 2, 4, 23, 0.08, 50.9
7260, 204, 2, 4, 22, 0.08, 75.9
7260, 204, 2, 4, 21, 0.06, 111.4
7260, 204, 2, 4, 20, 0.58, 149.1
7260, 204, 2, 4, 19, 2.04, 207.4
7260, 204, 2, 4, 18, 4.95, 258.0
7260, 204, 2, 4, 17, 8.12, 302.0
7260, 204, 2, 4, 16, 11.61, 344.8
7260, 204, 2, 4, 15, 15.52, 380.7
7260, 204, 2, 4, 14, 22.14, 437.4
7260, 204, 2, 4, 13, 28.99, 504.5



Highlight all of displayed data, including titles (CTRL+A), and copy it (CTRL+C). The data should
now be highlighted and on the clipboard.

Open a Notepad document (to find Notepad, go to Start > All Programs > Accessories > Notepad).
Paste the data into Notepad (CTRL+V).

Save the data (CTRL+S) as “HOT” in a location specified by your teacher.
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B. Importing the data into Excel

[0 Open Excel. Click the Office button ““in the upper left corner and click Open in the dropdown

menu.
1 At the bottom of the Open dialog box, where it says Files of type: All Excel Files, click and select All
files.
[ Locate your Notepad document labeled “HOT”, select it, and then click Open.
0 A Text Import Wizard box will open. Select Delimited for Original Data Type and click Next.
[0 Add Comma as a delimiter by clicking on the box next to Comma, and then click Finish.
] Once the data have been imported, save the file as an Excel Workbook. Click the Office button
mﬂ‘-/, and select Save As. In the Save As dialog box, under the Save as Type menu, select Excel
Workbook. If you are asked to replace “HOT.txt”, click yes.
BATS Program

A. Extracting the data
[0 Navigate to http://bats.bios.edu/ to access the online data system.
O In the left-hand menu, click on Bottle Data.
[ Change the following:
[ Enter Cruise Number: “10238” (for the August 2008 cruise)
[ In the Discrete Data section, check all of the following:
[0 Deployed: Year Month Day
[0 Depth (m) (already checked) and Nitrate + Nitrite (umol/kg)
Leave other settings as they are.
[ Click Get Bottle Data.
[ A table called Details of Extracted Bottle Data will appear. At the bottom of the page, select Click
Here to View Data.

The data will be displayed in a similar format to that of the HOT data shown above, but notice that
there are different columns. Because we are comparing the same type of data from different sources,
there are differences in the way the samples are numbered and displayed. Later, we will pull out just
the data that we need.

[ Highlight the displayed data (CTRL+A) and copy it (CTRL+C). The data should now be highlighted
and on the clipboard.

Open a Notepad document (to find Notepad, go to Start > All Programs > Accessories > Notepad).
Paste the data into Notepad (CTRL+V).

Save the file (CTRL+S) as “BATS” in a location specified by your teacher.
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B. Importing the data into Excel

ooooOo OO0

Go to Excel. Click the Office button m:‘-/, and then click Open.

In the Open dialog box, where it says All Excel Files in the lower right corner, click and select All
files.

Locate your Notepad document called “BATS”, select it, and then click Open.

A Text Import Wizard box will open. Select Delimited for Original Data Type, then click Next.
Add the Comma as a delimiter by clicking on the box next to it, and then click Finish.

Once the data have been imported, save the file as an Excel Workbook. Click the Office button

m:f, and select Save As. In the Save As dialog box, select Excel Workbook under the Save as Type
menu. If you are asked to replace “BATS.txt”, click yes.

Note: In column A, you may see the data displayed as exponents (1.02E+08) because the numbers are
longer than the column width. To see the entire number, put your cursor on the line between columns A

and B so that the cursor looks like this: ‘+’, and then double click to automatically adjust column width.

C. Filtering the data in Excel

We extracted the data from every CTD cast during BATS cruise 10238, but nitrogen samples were not
collected for every bottle from every cast. The BATS data system reports depths without a measured
nitrogen concentration as -9.99. Before graphing the BATS data in Excel, the depths with no nitrogen data
need to be removed.
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Highlight column D (labeled NO3) by clicking on the D. )

i
Click on the Data menu at the top of the screen, and then select Filter fiter. Arrows for dropdown
menus will appear in row 1 of your spreadsheet.

Click on the arrow ™. next to NO3.
In the dialog box, click on Select All (which will uncheck all of the values), check the -9.99 box, and
click OK. Only the rows with a NO3 value of -9.99 will be showing.

Now you need to delete rows 2 through 271 (because they are all -9.99):

ooOo OO0

] Put your cursor on row 2 (the number 2 on the left-hand side) so that it looks like this: =
Click and drag the cursor down to highlight all the rows through row 271.

[ Right-click on the row labels (the numbers on the left-hand side).

[ Select Delete Row.

Click on the arrow =%/ next to NO3.

In the dialog box, click on Select All, and then click OK. The remaining data should reappear.
While all the data is still highlighted, sort the data by depth.

Click on Data > Sort E

In the Sort by drop box (on the left), click on Depth, and then click OK.

Save your file!



HOT & BATS: Organizing the data in Excel
Now you are going to compile the data extracted from the HOT and BATS websites.

A. Compiling the data into one spreadsheet

‘n.

0 Open a new Excel worksheet by clicking the Office button| ", and then clicking New. Select the
Blank Workbook, and then click Create.

O Save the file as “HOT-BATS”.

Return to your “HOT” Excel worksheet, and copy the nit (Nitrate + Nitrite) and press (Depth) columns:
[ Select both columns by first placing your cursor over the letter at the top of column F so
that it looks like this: 8. Then click and drag the cursor to the right to highlight both
columns F and G.
[ Copy the columns (CTRL+C), and then go to your new “HOT-BATS” spreadsheet, select the
first two columns, and paste the data (CTRL+V).

Remove the cells in the second row that contain umol/Kg and dbar:
[0 Put your cursor on row 2 (the number 2 on the left-hand side) so that it looks like this: =
[ Right-click and select delete.

[J Rename the columns: click on cell A1 and type “HOT”, and then click on cell B1 and type “Depth”.
Remember that in this case, press (pressure) is equivalent to depth in meters.

Return to your “BATS” Excel spreadsheet and copy the NO3 (Nitrate + Nitrite) column:
[ Select the column by placing your cursor over the letter at the top of column D, and left
click.
[ Copy the column (CTRL+C), and then go to your new “HOT-BATS” worksheet, select column
D, and paste the data (CTRL+V).

0 Rename the column “BATS”.

[0 Go back to your “BATS” Excel spreadsheet, copy (CTRL+C) the Depth column (column C), and paste
it (CTRL+V) into column E in your “HOT-BATS” spreadsheet.

[ Save your work (CTRL+S).

B. Making a graph
Now that you have successfully imported and filtered the data from both the HOT and BATS websites, you
can make a graph comparing the data from these two studies.

In your Excel worksheet called “HOT-BATS” sort your HOT data according to depth:
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[ Highlight columns A and B and select Data > Sort o .
[J Under Sort by, choose Depth and select OK.

Now you are ready to return to step #8 on your STUDENT WORKSHEET - Lesson 4: Nutrients and Ocean
Circulation (Excel 2007).



basal sliding

chlorophyll a

conductivity

CTD

current

decomposition

density

dissolved organic
matter

Hawai‘i Ocean
Time-series (HOT)

MGobius Strip

model

Niskin bottles

nutrient

organism

parts per thousand

(ppt)

photosynthesis

pycnocline

GLOSSARY

The sliding of a glacier over the surface it rests on. Basal sliding is accelerated when
meltwater decreases friction between the glacier and the surface the ice is on.

The molecule that enables plants to use sunlight to make food. Chlorophyll also gives plants
their green color.

A measure of how well a substance can move electricity. In water, conductivity increases
with increasing salinity. Instruments measure conductivity and make calculations to report
the value as salinity.

An instrument used to measure Conductivity, Temperature, and Depth of seawater.

The steady flow of surface ocean water in a given direction.

The process by which tissues of a dead organism and other organic matter are broken
down, usually by bacteria, into simpler forms of matter.

The mass of a substance per unit volume (density = mass/volume).
A diverse group of compounds that include fats, sugars, proteins, vitamins, and other

molecules produced by living organisms. These compounds are released into the ocean
when cells die and break down, or through the excretion of waste material.

An oceanographic research program that studies long-term changes in the
marine chemistry, biology, and physics at Station ALOHA. Established in 1988, the HOT
program conducts research cruises almost every month.

A continuous closed surface with only one side. It is formed from a rectangular strip by
rotating one end 180° and joining it with the other end.

A representation of a complex system in a simple form.

(niss-kin); Canisters that are used to collect water samples from various depths. These are
often used in combination with a CTD.

A substance that an organism must obtain from its surroundings to survive and grow.
Example: nitrogen, which is needed by every organism to make proteins and DNA.

A living thing.
A measure of the concentration of a substance out of a total of 1000. Example: Seawater
has an average salinity of 35 ppt, which means that there are 35 g of salts in every 1000 g of

water.

(foe-toe-sinth-uh-sis); The way that plants make food. Photosynthesis requires sunlight,
carbon dioxide and water, and produces sugar and oxygen.

The location in the water column where the density changes rapidly with depth; pycno
means dense or thick and cline means change or slope.



respiration

salinity

Station ALOHA

stratification

thermocline

upwelling

water column

The process by which organisms convert nutrients into energy (for example, for
locomotion).

The concentration of dissolved salts found in a sample of water, measured in parts per
thousand (ppt).

A deep-water study area in the Pacific Ocean, located approximately 60 miles north of the
Hawaiian island of O‘ahu. Station ALOHA is the primary study site of the Hawai‘i Ocean
Time-series (HOT) program.

The process of arranging or becoming arranged in distinct layers.

The location in the water column where the temperature changes markedly with depth;
thermo means heat and cline means change or slope.

The vertical movement of water from depth up to the surface.

A conceptual cylinder of water from the surface to the bottom of a stream, lake, or ocean.



center for microbial oceanography: research and education
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TEACHER EVALUATION
http://www.surveymonkey.com/s/CMORE-kit-evaluation

1. Please circle the C-MORE science kit used:

Marine Debris Ocean Acidification Plankton
Marine Mystery Ocean Conveyor Belt Random Sampling

Nautical Knots and Maritime Careers

2. | borrowed this science kit from

3. Please rate how strongly you agree or disagree with each of the following statements.

Strongly Strongly
Disagree Disagree Neutral Agree Agree
Online kit reservation was easy. 1 2 3 4 5
Picking up this science kit was difficult. 2 3 4 5
This science kit was easy to use. 1 2 3 4 5
The Teacher Guide was difficult to follow. 1 2 3 4 5
My students enjoyed using this science kit. 1 2 3 4 5
| would not borrow this science kit in the future. 1 2 3 4 5
| will borrow other C-MORE science kits. 1 2 3 4 5

Comments:

4. Are the time estimates given for each lesson reasonable? If not, please explain.

5. How did you use this science kit? (Example: in a 6th grade public school classroom to introduce a unit on...)

6. Did you use the entire science kit? If you omitted any lessons or activities, please list which ones and explain why
you skipped them.



7. Were your students involved and interested in the science kit activities?

8. Please suggest two things that could be improved.

9. Any other comments?

10. Please tell us about your students. As we are committed to serving underrepresented populations, please estimate
the number of your students in the following categories:

School (optional): Grade(s) kit was used with:
____Total number of students

____African American ____Learning disabled

____Filipino ___Eligible for free or reduced lunch
____Hispanic ____Neither parent attended college
____Native American ____Physically disabled

____Native Hawaiian or Pacific Islander
____ Other (please specify)

11. Please fill out the following information if you would like to be notified of other C-MORE programs (workshops,
GEMS grants, teachers aboard research ships, etc).

Name

City/Town

State

Zip
Email Address

Thank you for your feedback.



Contents of Binder:

Ocean Conveyor Belt

Use the boxes to check off each item as you reassemble this kit.
Note: This checklist is two pages.

1. Front pocket

J
J
D

CD (contains narrated PowerPoint and electronic versions of binder materials)
C-MORE Key Concepts in Microbial Oceanography brochure
C-MORE Microbial Oceanography: Resources for Teachers brochure

2. Front Material

J
J

OCEAN CONVEYOR BELT (provides a general overview & standards addressed)
TEACHER SUPPLEMENTAL INFORMATION

3. Lesson1Tab
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TEACHER GUIDE - Lesson 1: Water Stratification

OCEAN CONVEYOR BELT SURVEY - Lessons 1 and 2

TEACHER ANSWER KEY to OCEAN CONVEYOR BELT SURVEY - Lessons 1 and 2
MATERIALS PHOTO GUIDE - Lesson 1: Water Stratification (Teacher Supplies)
MATERIALS PHOTO GUIDE - Lesson 1: Water Stratification (Water Containers and Student
Supplies)

HOT WATER DISPENSER GUIDE - Lesson 1: Water Stratification

SALINITY METER GUIDE - Lesson 1: Water Stratification

SALINITY APPROXIMATION TABLE - Lesson 1: Water Stratification

Color-coded GROUP EXPERIMENT cards (8)

STUDENT WORKSHEET - Lesson 1: Water Stratification

TEACHER ANSWER KEY to STUDENT WORKSHEET - Lesson 1: Water Stratification
POWERPOINT SCRIPT — Lesson 1: Water Stratification

4., Lesson 2 Tab

I I Y O B

TEACHER GUIDE - Lesson 2: Deep Ocean Circulation

POWERPOINT SCRIPT — Lesson 2: Deep Ocean Circulation

STUDENT WORKSHEET - Lesson 2: Mapping Deep Ocean Circulation

MOBIUS STRIP (Part A) — Lesson 2: Mapping Deep Ocean Circulation

MOBIUS STRIP (Part B) — Lesson 2: Mapping Deep Ocean Circulation

BLANK WORLD MAP

TEACHER ANSWER KEY to STUDENT WORKSHEET - Lesson 2: Mapping Deep Ocean Circulation
TEACHER ANSWER SHEET — Deep Ocean Circulation Map

NATIONAL GEOGRAPHIC NEWS article

STUDENT WORKSHEET - Lesson 2: Ocean Circulation Article

TEACHER ANSWER KEY to STUDENT WORKSHEET - Lesson 2: Ocean Circulation Article

5. Lesson 3 Tab

[ I R

O d

TEACHER GUIDE - Lesson 3: Using Data to Explore Ocean Processes

POWERPOINT SCRIPT — Lesson 3: Using Data to Explore Ocean Processes

STUDENT WORKSHEET — POWERPOINT - Lesson 3: Using Data to Explore Ocean Processes
TEACHER ANSWER KEY to STUDENT WORKSHEET — POWERPOINT — Lesson 3: Using Data to
Explore Ocean Processes

STUDENT WORKSHEET — HOT-DOGS - Lesson 3: Using Data to Explore Ocean Processes
TEACHER ANSWER KEY to STUDENT WORKSHEET — HOT-DOGS - Lesson 3: Using Data to Explore
Ocean Processes



6.

Lesson 4 Tab

TEACHER GUIDE - Lesson 4: Nutrients and Ocean Circulation

OCEAN CONVEYOR BELT SURVEY — Lesson 4

TEACHER ANSWER KEY to OCEAN CONVEYOR BELT SURVEY - Lesson 4

POWERPOINT SCRIPT — Lesson 4: Nutrients and Ocean Circulation

STUDENT WORKSHEET - Lesson 4: Nutrients and Ocean Circulation (Excel 2003)

STUDENT WORKSHEET — Lesson 4: Nutrients and Ocean Circulation (Excel 2007)

TEACHER ANSWER KEY to STUDENT WORKSHEET — Lesson 4: Nutrients and Ocean Circulation
STUDENT INSTRUCTIONS — Lesson 4 Extension: Data Extraction (Excel 2003)

STUDENT INSTRUCTIONS - Lesson 4 Extension: Data Extraction (Excel 2007)

Oo0oogogoogod

7. Glossary Tab

[J  GLOSSARY

8. Teacher Evaluation Tab

[J Completed TEACHER EVALUATION

9. Supply Checklist Tab

[J Completed SUPPLY CHECKLIST

10. Back Pocket

[J Manuals for Hot Water Dispenser and Salinity Meter

Lesson 1 Supplies:

J
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[

Large plastic tanks with bottom and one side painted white (3)
[J Clip-on labels for tanks during group experiments (2)
[J One large plastic re-sealable bag containing:

(0]

O O0OO0OO0OOOoOO0o0ODOo

(0]

Wooden blocks (3)

1500 ml Measuring Bottle (1)

1000 ml Demonstration Water bottle (1)

250 ml beakers (4)

100 ml beakers (2)

Probe Rinse Water beaker (1)

Measuring spoon sets (% tsp, % tsp, 1 tsp) (2)

Plastic spoons (2)

Small container for salt (1)

4 colors of food dye: Red, Yellow, Green, and Blue (2 each)

Oakton SALT 6 hand-held salinity meter (1)
Small plastic tanks (7)
Small plastic re-sealable bags (7), each containing:

(0]

O O O O

(0]

Wooden block (1)

100 ml beaker (1)

Measuring spoon set (% tsp, % tsp, 1 tsp) (1)
Plastic spoon (1)

Small salt container (1)

2 colors of food dye: Red and Blue (1 each)

Hot water dispenser with power cord
Red cooler

Collapsible water container

Extra salt for refilling small containers
Lessons 2 Supplies:

J

Other Supplies:

Laminated Mobius strip teacher answer key

[1 Colored pencils (14 each of red, blue, and purple)
[1 Scissors (7)

[J Transparencies of Surface Ocean Currents (7)

[J Speakers



